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1 Welome to Transactor

Welcome to Transactor! 

We hope you will find the program intuitive, efficient and reliable.

Transactor stores details of your surgeons, practices, products/services, patient
names and jobs. It handles job tracking, payments from surgeons and produces job
tickets, quotes, delivery notes, credit notes, invoices, statements, price lists, and
other reports.

This help is designed both as a course in using Transactor and as an ongoing
reference. 

While you are trying Transactor you are entitled to free Technical Support .

IMPORTANT:  Windows Vista or Windows 7 users please read System
Requirements

Getting started – new users

Skip straight away to Getting Started  which also introduces the Coffee Break Tour  to
familiarize yourself with the basics of the program.

When first installed Transactor has many advanced features hidden to make it easier to use, so if
you can't find how to do something see Configuration and Preferences ,   More Advanced
Procedures  and Getting help . 

If you wish to produce reports on Technician work completed you can enable this feature after you
have installed and got to know Transactor. See Assign technician and work units to items

Existing users

See Version History

Help File Version: 14 Sep 2010

2 System Requirements

Recommended

Single PC installation:
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An IBM Compatible PC running Windows XP Professional or Windows 7(32bit)

Network / Multi-user installation:
You must choose either Windows XP Professional or Windows Server 2000/2003/2008

Other Platforms

Transactor will run also run with Windows 98, Microsoft Vista 32BIT , Windows® 7 Home Premium
32BIT but these will not run Transactor in Networked Multi-User configuration. These platforms are ok if
you plan to stay with a single PC installation but you need to set Transactor Shortcuts to Run As
Administrator.  Please read Do this if you have Vista 32bit or Windows 7 32bit

Windows 7 64bit 

The current version of Transactor still uses a tried and tested 16 bit database and falls into the group
now classed by Microsoft as 'Older Windows XP Applications'. Older Windows XP Applications are best
with Windows XP Professional or Windows 7(32bit).

Although we still recommend Windows XP Professional or Windows 7(32bit), Microsoft has made it
easier to run older applications such as Transactor by using the Windows XP Mode with Virtual PC

See the website FAQ:  How do i run Transactor on Windows 7 (64bit)

Apple MAC

There are FAQ solutions for running PC applications using an emulator. See the website FAQ  I have an
Apple Mac .

Also See:
Find out what operating system you computer is using

3 Introduction

The topics in this section provide some basic information about Transactor, what it is for and what you
can do with it. 

10
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3.1 Why Transactor?

Save time

Transactor will organise your lab. Surgeons and Technicians will appreciate being able to
obtain up-to-date accurate information about any job that is in the lab (booked in), out of the
lab (booked out ongoing) or booked out and charged for. 

Despite its power the user interface and work flow are amazingly intuitive so you don't need to
spend weeks learning how to use the system. 

Booking In is fast because some input boxes are pre-filled based on your preferences. Some
preferences are associated with the surgeon account so for example the default (starting)
Price Band could be 'Private' for one surgeon but 'Intermediate' for another.

Booking out is also fast, even the printing behaviour (what to print and when) can be set up to
match what you normally print when you book a job out (and when asking for your printing
preferences, Transactor differentiates between Bookout Ongoing, and Bookout Charge).

Quickly trace any job by Doc no (AKA Job no),  Job Reference, Surgeon, Surgeon History or
Patient.

Save money

Professional, well-organized and prompt invoices and statements can significantly increase
your Lab's value in the eyes of your customers. At the same time it will also increase staff
satisfaction, generating a positive snowball effect.

Properly charge for each and every job. It's all there on screen, the correct price for each job
item. Use the Booked Out Jobs report to identify and charge for jobs that were sent out on an
ongoing stage, but never returned by the Surgeon.

Using your Lazer printer to print your own Invoice and Statement letter heads with or without a
colour logo, you can save on monthly costs of old style pre-printed stationery. 

Review your monthly statements on screen, to preview window, to check jobs have been
correctly charged for and payments entered. Make your amendments before you print and
waste paper.

Concentrate on your work

Transactor's intuitive user interface is transparent and straightforward. All the technical details
are handled in the background by the program. What you see is what you get. You can spend
most of your time getting on with your work rather than handling paperwork and phone calls.

Work in a team

Transactor can be expanded to Networked Multi-user so you could for example be booking
work out work on one pc, and booking in or looking up or amending job details on another,
simultaneously. 

Using a computer to track your jobs, and do your invoices or statements can be fun

Don't believe it? Give it a try with Transactor...
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3.2 Features

Dental Lab Transactor is a professional Dental Laboratory administration software package with the
following main benefits.

Easy to get started
Use the Coffee Break Tour, Quick Start Tutorials, and Step-by-step setup wizard

Fast booking in and out
It's never been this easy to process jobs. The main Form gives you quick access to all Jobs,
Patient, Surgeon and Surgery details.

Flexible Invoicing
Invoice per job or by monthly summary invoice or a standard account statement

Powerful Job Tracking
even if you don't have the job number handy

Customizable Job Details
Reduce repetitive typing by setting up default entries and template line items to go on new Jobs.
Collect additional information using custom fields.

Surgeon and Patient Search
Quickly locate jobs by surgeon or patient

Flexible Printing
Transactor can print your own logos or printing background to blank stationery. Professional
looking printouts using either standard blank inkjet/laser paper, or print to your pre-printed
stationery. Configure printing of selected documents such as Delivery Notes, to occur when you
Book Out work, or to a batch queue for printing out together. Label printing reports for Surgeon or
Practice names and addresses.

Patient Statements
Patient Statements on demand or automatically printed as required. Conforms with the MHRA
guidance on MDD 2007/47/EC. 

Self contained
Invoicing, Credit Notes, Receipts, Allocation of Receipts to Invoices, Quotes and aged
Statements are built in.

Expandable to Networked Multi-user
When you expand, Transactor is networkable for up to 20 terminals.

3.3 The User Interface

The Transactor window is dominated by the 'all-in-one' Main Form from which you can perform virtually all
your lab administration operations by pointing and clicking, or by using a Hot Key.
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The Transactor Window showing the Main Form

The Toolbar  and Main Menu

The Main Menu Toolbar (or Toolbar for short). Quick access to useful functions which are also available
from the standard windows Main Menu.  

The Main  Form

The Menu Form displays the the job details in a Job Document, including the Surgeon, Practice and Due
Date.  

In the Line items area several types of Line items can be entered.

Special Template Line Notes eg. Patient, Shade etc
Product/Service line items
Line Notes

Line items template area

This area appears automatically when each new job is started and this is where the Patient and other
required common details are gathered. More, or less, information can be gathered by customizing this
template area using the Setup Wizard. See New Document Setup

Line items - products & services or line notes

This area is where you enter the Job Item details, such as Product Codes for work (services) or physical
stock items. These items normally have a chargeable value populated from the selected price band.

7
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You can also enter as many Line Notes as required. These Line Notes will be printed on any Invoices/
Despatch notes. If you want the note to be only internally visible, use the Internal Note area shown near
the bottom of the Main Form.

Function Bar

This shows what Hot Key Functions are available to you depending on what you are doing at the 
moment (The fancy name for this behaviour is 'Context Sensitive').

Also See
Coffee Break Tour
Modifying, Deleting & Inserting Line Items

3.3.1 The Main Menu

The Main Menu can be accessed by clicking, or by holding down the Alt Key and pressing the shortcut
key which is shown underlined.

Most regularly used menu items have Hot Key reminders..

For example if you are entering details in a Job, hold down CTRL and press DEL to delete the currently
selected line item row. There is no need to use the mouse to go to the menu.

Available and unavailable (grayed out) menu items

14

60
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When you drop down a menu, you may see some menu choices are not available. These choices are
not appropriate for what you are doing on the Main Form at the moment.

In the above example, the Action Menu was invoked (F9) just after a new job was started. The Main
Form has some but not all the details about the new job on it. 

Example: these items are unavailable when you are modifying a new job

New Job : A new Job Document is already on the Main Form.

New Credit Note : The Main Form is being used for a New Job. If you want to start a new Credit
Note, first choose Delete.

Copy to New : There's not enough details to copy this job's details to start another new job with.
Once the Job is Booked In, or Out, then it can be copied.

Modify : This Job Document is already being Modified

Finalise :  Only Credit Notes and Customer Querys can be Finalised. Normal Jobs are Finalized
automatically on the Book Out Charge stage

Print : You are given the opportunity to print this job on Book In, Book Out or if the job is retrieved
onto the Main Form and is not being Modified.

3.3.2 The Toolbar

This toolbar contains one-click availability of some commonly required functions. These functions are
also available under the standard menu but instead of searching for them in drop-down menus they are
all available directly. 
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The tool bar is context-sensitive, automatically displaying the functions relevant to what you are doing at
the moment. Functions that cannot be used in the current context are grayed out.

3.4 Getting help

Your main source of information should be this help file and the website's FAQ and Knowledge Base.
You may also contact Transactor Sales & Support.

Using the FAQ and Knowledge Base

The online FAQ and Knowledge Base is a wonderful resource that contains the latest version of the
Frequently Asked Questions given in this help,  and also a Knowledge Base which you can search.
The online FAQ is located at www.transactor.co.uk on the FAQ page.

Use the Coffee Break Tour tutorial

if you have not already read the Coffee Break Tour, we recommend you do so now. 
The tutorials talk you through using the Example Lab company which was installed automatically
alongside your empty 'Live' Transactor.

Getting a printed user manual

There is a printable PDF manual supplied in the Transactor v61 program group (under the Windows Start
Menu).

This manual is in the common PDF format. Free PDF viewers are available on the internet if you do not
already have one installed. Currently our favorite is Foxit Reader. To print the manual we recommend a
colour Lazer Printer.
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3.5 How to buy Transactor

Contact your distributor:

Credit Card or Paypal:

Transactor Website

 www.transactor.co.uk

Other methods:

Check our website for prices or ring our Sales and Information line.

Transactor sales and information line:

 01424 777877

Other payment methods accepted:

Cheque:

Make cheques payable to Pearce & Robinson LTD and post to:

Pearce & Robinson LTD, 17 High Street, Battle, East Sussex TN33 0AE

Please provide your full lab name, address and contact details. You will be sent a CD and
Invoice.

Bank Transfer:

Make the transfer to Sort Code: 089303    Account Number: 70858143  Ref: (your Lab
Name)

Please ring the sales and information line

You will be sent a CD and Invoice.
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4 Getting Started

If  you  have  already  installed  Transactor  we  recommend  you  start  with  the  Coffee  Break  Tour
otherwise Install Transactor  first.

So with Transactor Installed and the Coffee Break Tour completed you should  Set  up  Transactor  for
your lab . 

DON'T  worry  about  making any mistakes at  this  stage since  you  can  clear  down  the  data  and

start from scratch. 

DO  Get  help  if you are stuck  or are looking for a feature and  can't  find  it.  There's  a  lot  more  to

Transactor behind the scenes that meets the eye! 

 

4.1 Install Transactor

If you have already installed Transactor from a CD or from the website download, skip to either Do this if
you have Vista or Windows 7  or Use the Coffee Break Tour

Installing Transactor

Start your PC.
Close any Windows programs that may be running.
Insert the Transactor CD into your CD drive. The Setup program should automatically run. NOTE:
If the program does not auto-start double click the Setup.exe file located on the CD.
Click Next on the Welcome screen and follow the on-screen instructions.
The setup program will install the main Transactor icons onto your desktop. NOTE: You can also
access all the Transactor icons by clicking on Start / All Programs / Transactor v61.

IMPORTANT – Windows Vista or Windows 7 users
For Transactor to run correctly on your PC please see System Requirements

4.2 Do this if you have Vista 32bit or Windows 7 32bit

Configure Transactor for Vista (32bit) or Windows 7 (32bit)

Vista and Windows 7 have extra security features compared with older versions of Windows so we need
to make a few extra settings after installing Transactor before the Transactor programs will run properly.

The properties for the each of the Transactor Shortcuts must be set to 'Run as administrator' as
follows:

Right click the Transactor v6.1 shortcut on your Windows Desktop

11
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Choose 'Properties' from the popup menu.
In the Properties window, click 'Advanced...'
Tick 'Run as administrator' and click OK.
Click OK again to close the Properties window

Do the above for each of these other shortcuts found in the windows Start Menu All Programs (or
Program Files)-Transactor v61

Maintenance Menu
Transactor Example Co
Transactor v6.1 

Notes

In Vista, if you want to turn off the permission warnings each time you run the program you can turn
User Account Control off. See the readme.txt file in C:\tran61\lab\exe or Contact Us .

Don't worry if If you are unfamiliar with these terms, Contact Us  and we will talk you through it

Also See:
Getting help  

Website FAQ:   How do i run Transactor on Vista(32bit) or Windows 7(32bit) 

4.3 Use the Coffee Break Tour

Using the Coffee break tour

Do the Coffee Break Tour  now to get  familiar with using Transactor Example Co which will  give you
hands-on experience using example lab data.

Anything you do with the example lab data will not affect your live system.

Once you have completed the tutorials you are ready to Start your live Transactor  and then Set up
Transactor for your lab

 

4.4 Start your live Transactor

To Start Transactor

Double-click the Transactor icon on your desktop

185
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or

 From the Windows Start Menu choose All Programs (or Program Files)-Transactor v61-
Transactor v61

Logging On

In the standard single user installation you will not need to log into Transactor.

If you are prompted to logon, type MANAGER as the Username and leave the Password  box blank.
Click OK.

Logging on with a username and password is optional in the single-user version of Transactor. If later on
you want to force anyone who uses Transactor to log in you can use the Setup Wizard to Enable
username and password log in

Note: MANAGER is the only account set up initially after installing Transactor. 

See Also
Add or delete a user
Change a User Password
User Preferences

4.5 Set up Transactor for your lab

By now you would probably have done the Coffee Break Tour  but if not we strongly recommend you
do so unless you are very familiar with this type of computer software.

Having completed the Coffee Break Tour you are now ready to start  using the live  Transactor  for  your
lab. 

The Setup Wizard starts  automatically  (until  you  set  up  your  laboratory  name)  after  you  start  the  live
Transactor, thereafter you can start it at anytime from the Tools menu or toolbar.. 

The following steps guide you through entering your lab setup information needed before jobs can be
booked in and out of Transactor.

1. Start your live Transactor

2. Use the Setup Wizard  to specify  your  lab  company  details  including  Surgeon  accounts  and
products/services.

3. Adding Opening Balances  to your Surgeon Accounts.

4. Set  up  other  optional  preferences.  (See  New Document  Setup ,  Printing  Setup  and  User
Preferences ).

5. You can now process your jobs. 

148
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If you wish  to  produce  reports  of  Technician  work  completed  please  see  Assign  technician  and  work
units to items  and Users/Technicians

See also 

Basic Working Procedures

4.6 Back up your Data

Regular backups are very important to protect your business from computer failure. You may backup
your computer's data using your usual IT procedures, but we recommend you also use the built in
Transactor backup.

The process is fast and easy once you have used the wizard's Data Backups  page, so that
Transactor knows which device or data drive you are backing up to.

To Backup your Transactor Data

Insert your external storage device if you use one
In Transactor, choose Exit.. from the File  menu
In the End Session window, choose the Exit Transactor and Backup data..  option and then click
Yes
When the backup has completed, remove your external storage device

Note
In the trial system, the option to do the standard backup on exiting Transactor is disabled although
you can still do a manual backup
For a full description of backing up (and restoring) your data, see Backing Up & Restoring Your Data

.

4.7 Register Transactor

If you have purchased Transactor and have obtained a registration key, you must enter the details  into
the system so that you can continue to use Transactor after the 40 day trial period.

Also see: How to buy Transactor

To register 

1. Start Transactor  

2. If the free trial period has expired you  will  be  presented  with  the  Transactor  Registration  window.

64 125
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Otherwise, choose Transactor Registration… from the Help  menu.

3. Enter  the  details  supplied  in  your  confirmation  letter.  It  is  important  that  you  enter  these  details
exactly as they are written, including use of Capitals.

4. Click on Register. You should see Transactor Registered Successfully

5. Click OK

If your registration is not accepted by Transactor see Getting help

5 Coffee Break Tour

Welcome to the Coffee Break Tour

Use this  tour to get  familiar with using Transactor.  If  you  haven't  yet  installed  Transactor  see  Install
Transactor

For more details on the procedures described in the tutorials please refer to Basic Working Procedures
 in Transactor Help.

DO  feel  free  to  experiment,  because  anything  you  do  here  won't  affect  your  main  'Live'  Transactor

system.

So get the coffee on and let's get started. Tour the Main Form

Do you prefer a printed tour?

If you prefer to print out this tutorial a printer-friendly version is available as follows:

From the Windows Start menu, choose All Programs (program files) - Transactor v61 - Printable
Coffee Break Tour

If your computer is not able to open PDF files, you can get a free PDF Viewer from the internet.
One such viewer is available from www.foxitsoftware.com or www.adobe.com

In the PDF viewer, from the File Menu, choose Print

8

10

40
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5.1 Tour the Main Form

Let's start by taking a look at  Transactor's  Main Form using the example lab data called DentaLab LTD
with its set of fictitious Surgeons and sample jobs.

Starting the example dental lab Transactor Main Form 

From the Windows Start menu, choose  All Programs (or Program Files)-Transactor v61-Transactor
Example Co

 
You should now see the Main Form. It may help to maximise this window.

Notice the caption at the top for the example company we are using, DentaLab Limited.

Notice the Menu Bar at the top and the Tool Bar underneath the menu bar.  The Tool Bar has some
useful buttons which we'll try in a moment.

Notice the Function Bar at  the bottom and the status  bar below it.  The Status  Bar at  the  bottom
usually displays a short helpful message.
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Using the Job Navigator tool

Just below the main menu, in the Tool Bar, click the View Last Document icon

 
You should see the last Job Document that was entered in the example DentaLab Limited system.

Notice the job details  are in a 'grayed  out'  text.  This  means  they  can't  be  accidentally  modified.
More on how to modify jobs later.

Try  the ‘View First  Document’  button and have a look at  some of the other jobs.  If you hover  the
mouse over the tool icons you will get useful hints.. 

Trying some other Actions and Functions

Hover the mouse over some of the other tool bar buttons to see what they do

Try Clear Form. Then point the mouse into the Surgeon Account area, and double click to bring up the
Surgeon selector. This is the same as choosing Surgeon - Select from the Main Menu.
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Note: You may see some menu choices, or Icons are not available. For example, if you have started, or
are modifying a job on the form, the Clear Form icon will be unavailable. This is because Transactor
doesn't want you to accidentally clear the form. Instead you need to choose an Action for the current job
eg. Book it in, Out or Delete it. Read more about this in the next section.

Once you’ve finished experimenting, press F12 to clear the form, or click on 'Clear Form' on the toolbar. 

You'll now be back to a clear Main Form.

5.2 Understanding Actions

Actions are 'Start New Job', 'Book In', 'Book  Out'  etc. You'll quickly become familiar with these 'Actions'
since the whole system is based around them.

Actions are done by choosing them from the Menu, but they are also available from the Function Bar at
the bottom of the Main Form.

The Function Bar is a handy way to quickly see what Actions you can choose. Some may be disabled
(grayed out) because it isn’t valid for what you are doing.  For example if you have no job details showing
on the Main Form, 'Book Out'  just doesn't make sense!

Let's do some simple Actions now just to get a feel for it. 

The New Job Action

From the Main menu, choose Action - New Job, or choose F3 New Job from the Function Bar.
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You will see that the top right of the Main Form shows the Doc No which is also the Job No. Notice
that the State box describes the job's status in full (New Job)., later on this could display 'Booked
In', 'Booked Out'  or 'Booked Out Charged'.

We'll cover New Jobs and Booking In later, for now we'll just practice aborting this new job, to go
back to a clear Main Form. A New Job has been started, Transactor won't let us simply click Clear
Form so we need to practice using the Delete Action.

From the Main menu, choose Action - Delete

Transactor doesn't want users to do things like deleting jobs accidentally, so it asks you for
confirmation. 

In the Confirm Action dialog, choose Delete Job

You'll now be back to a clear Main Form and we have demonstrated that after starting a job you can
Delete it rather than continuing. 

5.3 The Clear Form Action

Clear Form is frequently used. For example, if you have been using the Main Form to view a Job's details
then at some point you need to clear this Job from the form so that you can select a different Surgeon or
Job/Document.

The Clear Form is available from the Function Bar (F12), the Action Menu, and the Main tool bar icon.

If you are working on a New Job or modifying an existing job (i.e.  not  just  viewing),  you won't  be able to
clear the form because you need to Action the current job first (Action... Book-In/Book-Out/Delete etc.)
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To Clear the Main Form

First of all, lets retrieve a Job Document onto the Main Form so in the Tool Bar, click the View Last
Document icon

 
After viewing a Job Document click the Clear Form Icon on the main Tool Bar.

Sometimes you cant just Clear the Form. We'll explain this now. First of all retrieve the last Job
Document onto the Main Form again.
 

Now with a Job Document on the Main Form being viewed, from the Action menu choose Modify

Now click Modify Job to confirm
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Note the Job State has now changed from just 'Booked In', to 'Modify Job Booked In'. This Job-Document
for dental surgeon Mr B Adams, can now be edited. 

We'll assume that for some reason we want to mark this job such that when it is booked out, an Invoice
will not be raised. In other words, the job won't be charged for at this stage but it will be stored in a state
of 'Booked Out Ongoing'.

Click in the On Bookout box and Change it from 'Charge' to 'On-Going'

Now choose Action - Clear Form

  ...Having trouble ?
 
The Clear Form action is disabled\greyed out and Transactor will not let you clear the Form because you
may accidentally lose job details. Instead, if you want a clear form you first need to decide what you
want to do with this Job Document that is currently being modified. We could Book it back in, Book it
out, put it On Hold, or Delete it. Let's just do the most likely thing if we were modifying a Booked In job,
we'll Book it out.

Choose Action - Book Out (F8)
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Notice Transactor 'knows' this job is to be booked out without charging at this stage, so you are asked
to confirm Book Out Job Ongoing. Now you will see a clear form. If you choose View Last document
you'll see that the state of this job is marked as Job Booked Out Ongoing.

Now let's move on to Tour Surgeons

5.4 Tour Surgeons

Ok so far but now it's time to get to take a peek at selecting Surgeons and Practices onto the Main
Form.

If you already have a job on the form, choose Clear Form first.

Note: If the Clear Form function is disabled (greyed out) and you are unsure what to do, see 
Understanding Actions

Selecting a Surgeon for a job 

 
From the Surgeon menu, choose Select..

21
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In the Surgeon Account Selector’s list, choose 'Beresford'. There are three easy ways to do this. (i) By
double clicking the row with the mouse, or (ii) Hi highlight the row and press Enter. or (iii) Highlight the
row and click Select.

That  Surgeon  has  now been  selected  onto  the  Main  Form.  In  the  example  lab,  Mr  Beresford's
practice address is the same as his invoice address and so Transactor has no need to display  it  in
full. 

In case you are wondering, Surgeons can have several accounts,  each one working out  of different
practices. You'll see how this works in the User Guide.

We chose Mr Beresford  (account  no 274) as  the Surgeon in our example because  that’s  one  of
the four surgeon accounts that has sample jobs. The others are 'Adams', 'Dodds' and 'Kelly'.

If  you  know a  Surgeons's  account  no  you  can  use  it  to  quickly  select  the  surgeon  even  more
quickly. Let's try this but first remember to clear the form (F12).
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In  the Surgeon Account box,  type 274 and press Enter.

Mr Beresford's details are retrieved onto the Main Form. 

Another way select a Surgeon onto a clear form is by surname. Don't forget to clear the Main Form first.

In  the Surgeon Account box,  type the surgeon's surname (or just the first few letters of it) and press
Enter.

A window will appear showing any Surgeons matching what you typed. If only one account is showing
you can just press Enter to save time, otherwise highlight the correct account and then choose 'Select'.

In this topic we've shown you a few ways to retrieve a Surgeon's details onto the Main Form. You may
want to do this either to view the Surgeon's record, job list/history, or to assign the Surgeon to a New
Job. 

5.5 Understanding Surgeons and Practices

Let's spend a moment to understand how Transactor assigns and maintains Surgeons with Dental
Practices.

In Tour Surgeons  you saw how Surgeon Accounts are selected onto the Main Form for various day to
day tasks such as booking in a job. The Main Form Surgeon menu can also be used to Add and Modify
Surgeon accounts.

Let's now take a peek at the Surgeon Accounts page in the Setup Wizard because it's a good way to
show you graphically, how Surgeon's can work out of one or more Dental Practices.

21
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To view the Surgeon Accounts page in the Setup Wizard

From the Tools menu, choose Setup Wizard
In the Setup Wizard, choose Next until you get to the Surgeon Accounts page
Click on Battle Dental Surgery

A list of Surgeons will appear in the bottom window who work out of the selected Dental Practice.

Take a mental note that Mr J Blunt has a Surgeon Account assigned to this Practice. Suppose Mr Blunt
has just phoned to say he will now work out of Bohemia Dental Surgery as well as Battle Dental
Surgery.

In the upper window, select 'Bohemia Dental Practice', note there are already three Surgeons with
accounts at this Practice.
Click Add New
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In the 'Add New Surgeon Account' form, enter Mr Blunt's name and initials and click Ok

So now Mr Blunt now has two accounts, one of which is his new account for work sent to Bohemia
Dental Practice, and the other for work sent to Battle Dental Practice.
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Now click  on Back  to go to the Dental Practices  page.  That  is  where you can experiment  with  adding
new Dental Practices, or changing their details.

Click Finish to exit the Setup Wizard

You will find yourself back at the clear Main Form. If you choose Surgeon - Select from the Main Menu,
you'll see that Mr Blunt's name appears twice, once at each of the two practices he works out of. Notice
also that when the surgeon is shown on the Main Form, the distinct account number is next to the
account name in brackets i.e. Mr J Blunt BDS (143)

5.6 Jobs and Documents

In this topic we'll take a look at the various ways of handling jobs and documents on the screen. 

One common requirement is to view a list of jobs for a selected Surgeon. 

Using the Surgeon History

Select Dodds (204) onto the Main Form  (see Tour Surgeons )
From the Surgeon menu, choose  History (F11)..

You’ll  see a list  of jobs ‘Booked  In’  and  jobs  ‘Booked  Out  Charged’  for  'Dodds'  .  You'll  also  see  his
payments.

Highlight the job for the patient 'Parrish,M' (DocNo 1381) and click ‘View’.

21
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If you scroll  up you'll  see the items at  the top of Mr Dodd's  list  are  in  black.  This  means  they  are
'locked'  and  cannot  be  modified.  The  Main  Help  explains  about  Locking  and  Un-Locking  of  Job
Documents.

You’ll see a summary view of the selected job in a window.  We'll  go the whole hog and select  this  job
onto the main form.

In the Document window, choose ‘Select Onto Form’ 

Now we have a job shown on the Main Form. It  is  in a ‘Read’ or ‘Viewing’ state with  grayed-out  text,
this indicates you can’t accidentally modify any details. Look at  the Function Bar to get  a hint  of what
you can now do with this job/document. 
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In fact there are several ways to quickly retrieve job details onto a clear Main Form.

Surgeon History (which we have just used)
or Job Number
or View \ Booked In Jobs due by
Tools \ Patient Search  (You can type all or the first part of the patient’s name and press Enter). 
View \ Jobs-Documents (Scroll down to the selected Job).

Try each of these now. Clear the Main Form each time.

5.7 Booking In a New Job

You’ll need a clear Main Form so if there’s a job showing, you need to clear it first.

Starting a New Job 

 

From the Action Menu, choose 'New Job', (or press F3).

Notice the new Document No (The Job No) is visible on the right). This Example Lab is set up to do to
automatic job numbering but in your 'Live' system you can use the Setup Wizard to opt for manual job
numbering so that you enter the new job numbers yourself if you wish.

Select a Surgeon onto the Main Form. If not sure how to, see Tour Surgeons

For the moment we'll skip Usual Prices, On Bookout and Due Date info as these are explained in the
main Help. 

Enter a Patient name by double-clicking 'Patient' in the 'Code' column. 

21
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Now we'll move on and enter some Product/Services.

Place the cursor on a blank row in the Code column and press Enter, or choose Products & services
from the Product/Service menu.

Highlight an item such as 'BCP' and choose Select onto form... 

Verify or amend the price and quantity, then click OK.

On  another  blank  row,  press  Enter,  and  the  Products  and  Services  window will  appear.  You  can
change the properties of one of the line items.

o Right click the item and choose Properties

or
o highlight the item and click the Options button

In the Properties window you can change the price, description, or other properties. 

Close the Properties window if you have opened it.

Choose Select onto form

Repeat the above steps a few times to add a few more Products or Services.
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After you have specified the details of the job, we can proceed to Book it in.

From the Action Menu choose Book In (F7) and click OK
The Confirm Action window appears. Here you can choose to print a job ticket if you wish, or just
leave the output box blank.
Click Ok

That's it, the job is booked into Transactor, but It can be retrieved at any time.

Notes

The full User Guide has a lot more information for example:  

How you can use the keyboard instead of the mouse.Starting a New Job
Using automatic  job numbers  or  manually  typing  in  your  own  unique  job  number  each  time  you
start a new job.
Why in this example the Independent price band came up automatically  for this  Surgeon,  and how
a Surgeon's preferred price band can be configured.

Notice that this Job could be directly Booked In and Out straightaway by choosing Action-New Job
then  Book-Out.  You'd  only  want  to  do  this  if  the  work  had  commenced  without  the  job  being
booked into the computer (not a recommended practice).

Transactor didn't   print  anything when you  booked  the  example  job  in,  but  the  topic  Printing  On
Confirm  Action  shows  you  how Transactor  can  be  configured  to  prompt  you  for  your  usual
printing habits,  a  Job  Ticket  on  Booking  In,  Despatch  Notes  and  Invoices  on  Booking  Out.  Isn't
Transactor wonderful!

5.8 Booking Out a Job

After having tried some Booking In let's have a quick go at at Booking Out. 

NOTE
For more details and options refer to Booking Out a Job - (main Help) .

To Book Out a Job (Summary)

Retrieve the Job onto the Main Form
Edit/Modify  the Job if the details  need updating or the On-Bookout  box is  not  correctly  set  (to  either
'On-Going' or 'Charge').
Choose the Book Out action
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To Book Out a Job (step by step)

First ensure you have a Clear Form .

There are several ways to quickly locate and retrieve a Job on the computer.  The fastest  is  by  using the
Doc No,  also called a Job No.  We will  assume we don't  have the job  number  handy  and  select  a  Job
from Mr Beresford's history list.

Select  Mr  Beresford  onto  the  Main  Form.  If  you  don't  know  how  to,  see  Tour  Surgeons ,  then
choose Surgeon History.

In the Surgeon Account  History  window, highlight  one of the jobs at  the bottom with a description  of
'Job Booked In'.

In the Surgeon Account  History  window, highlight  one of the jobs at  the bottom with a description  of
'Job Booked In'.

18
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Click View, then in the next window press Enter to choose the Select Onto Form button.

From the Action Menu, choose Modify or press F4
Ensure the On-Bookout box is set to Charge. (in this example we want to finalise the job when it is
Booked Out this time).

From the Action menu, choose Book Out or press F8

In the Confirm Action window, ensure Output is set to Delivery Note to Practice (A4),  to Batch Queue,
then Press Enter.

That's it, this job is Booked Out and finalised. It will appear on this Surgeon's statement for this month. 
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After a batch of  jobs  have  been  booked  in  we  can  optionally  print  despatch  notes  with  Jobs  grouped
together by Dental Practice. See Printing a daily report

Note
If  required,  we  could  have  setup  Transactor  to  automatically  print  an  Invoice  as  well  as  the  batched
Despatch  Note,  but  there's  more  about  this  in  the  main  Help.  You  may  be  interested  to  know  what
happens if you notice a mistake after booking a job out.  Well normally  you can still  modify  the job and
book it back out again providing the lab manager hasn't  done a 'Locking' for the finalised (charged) jobs
in this date period. Again there's more about this in the main Help.

See also
Selecting an Existing Job  - (main Help)
Patient Search  - (main Help)

5.9 Printing a daily report

Printing a Booked In Jobs Report 

A typical daily report which is used for Job Scheduling.

From the Reports menu, choose  Jobs - Booked in jobs (by Due Date)
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You’ll get a few options but you can leave these as they are and just click OK.
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The report will come up in a print preview window.

To print a hard copy of the report, click the Printer icon on the Tool Bar.

Note: The above report is useful since it is effectively a Job Schedule showing booked in jobs by due
date, the most urgent at the top. Some larger labs use this report on a daily basis, choosing the other
flavor of this report specifying the due date in the report options.

Printing Despatch Notes to Practice

After a session of booking out jobs, we may want to print off the Despatch notes grouped by Dental
Practice.

From the Tools menu, choose Print Manager
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Notice the View group box is set to Un-Printed Batches by default.

Click Select All, then Print then Ok to see the Despatch notes in a Preview window (we won't print
them to a physical printer now).
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Notes
This report is very useful because the delivery driver will get one despatch note per Dental Practice even
if several Surgeons are at that Practice. Also notice the Checked by and Received by signature areas.

If you prefer to keep Delivery Notes per job, or per Surgeon then then you can do this too. See the main
Help.

5.10 Statements

In this  topic  we will  preview (but  not  print  out)  Statements  for  All  Surgeons  for  the  example  DentaLab
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Limited.

Printing surgeon statements

From the Reports menu, choose Surgeons - Statement (monthly)

You’ll get a few options but you can leave these as they are. 

Notice in this example, that the Surgeon A/c no. box is blank; this means we'll get a Statement for all
Surgeons. 

If the Surgeon A/c no box is not blank, this is because there was a Surgeon showing on the Main Form
when the Report menu was chosen; simply clear the 'Surgeon a/c no.' box.

Confirm that the 'Output To' setting is 'Preview Window' then choose OK. Individual statements for all
surgeons will be produced.
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Click on the Next Page icon to step thru the Statements.

If we wanted to print these statements (from the Printer Icon shown above), we could either print all
statements or specify the page number range.

Close the Preview Window.

To produce a statement for an individual surgeon, either select a surgeon onto the Main Form before
choosing the Report, or in the Report Options, type in the a/c number before clicking OK.

Try also… 

Running some of the other reports. As long as you leave the ‘Output to’ box as it is, all reports will
go to a preview window so you won’t need to waste paper. 

Try the Surgeon Summary Invoice report which summarises invoices for an individual surgeon
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account and month with a grand total amount. Some labs use this instead of printing individual
Invoices. 

Try re-running the Statements but this time choose the Surgeon Statement (date Range). This
means that the aged analysis at the bottom of the statement is 30/60/90 days rather than current
month/1mth/2mth/3mth. You will see which type is more suitable for the way you deal with your
surgeons.

5.11 What Next

That completes the Coffee Break Tour tutorial.

We recommend you now go to Start your live Transactor  and Set up Transactor for your lab  in the
main help.

After you have done the above, if you wish to produce reports  of Technician work  completed please see
Assign technician and work units to items  and Users/Technicians

We hope you have enjoyed your experience with Transactor so far.

Please contact us if you have any questions.

Website Contact Us: www.transactor.co.uk
Sales & Support Line:  01424 777877

Pearce & Robinson LTD
17 High Street, Battle, Sussex TN33 0AE
Tel: 01424 777877
www.transactor.co.uk

© 2009  Pearce & Robinson Ltd.  All Rights Reserved

6 Basic Working Procedures

This section describes the most common basic tasks you will use when working with Transactor. It is
designed as a "How-To" guide. You can use the table of contents as an index. Although it is organized
roughly in the order that you would perform the tasks you don't need to begin at the beginning and work
your way through. Most topics contain links to background information and other relevant subjects so
you can just pick out the task you need to perform and begin.

See also
Special Job Types
Introduction
Coffee Break Tour
More Advanced Procedures
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6.1 Starting a New Job

This guide assumes you have Transactor running with a Clear Form .

To Start a New Job

From the Action menu, choose New Job (F3)

A new Job/Doc number is generated and the initial job details are added to the job (see New
Document Setup ) 

Select a surgeon account (see Selecting a Surgeon Account )
In the Usual Prices box choose a price band most closely applicable to this job, and press TAB
Choose the On Bookout option 

On Bookout - 'On-Going'
When the Job is booked out, it will be temporary without charging. If you retrieve the job details

 during this period, the Job Status will display 'Booked Out On-Going'

On Bookout - 'Charge'
When the job is booked out. An Invoice will be generated on the system but may or may not be
printed at this point depending on your configuration  

Type in the Due Date and press TAB 

The cursor will now be on the first line in the Code.. column. This will normally be the PATIENT. 

In the Code column, with the Patient code highlighted, press the Enter key or simply start typing the
patient surname (Transactor will know you want to enter the Patient name).
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Depending on your New Document Setup  you may have further pre-set job detail lines to
complete, Notation for example.

On blank rows, in the Code column press Enter to add more lineitems to the job (see Selecting a
Product/Service )
From the Action menu, choose Book In, Book Out or Hold

Notes
To abort adding a new job, from the Action Menu choose Delete.

See Also
User Preferences
On Bookout Options
Adding a new Product/Service

6.2 Booking In a Job

To Book In a completely new job

Start a new job (see Starting a New Job ).
Choose Action - Book In (F7).
In the Confirm Action window, click OK.

To Book In an existing job

Select the Job onto the Main Form (see Selecting an Existing Job ).
If the job is eligible to be Booked In you will be able to choose Action - Book In (F7). 
Alternatively you can choose Action - Modify (F4), change the job details and then Book the Job
In.
In the Confirm Action  window, click OK.

Notes
In the Confirm Action  window, the 'Output to' selection can be pre-set for printing a Job Ticket  

151

59

152

130

62

41

43

98



Transactor Dental Lab43

© 2010 Pearce & Robinson LTD, all rights reserved

See Also
Coffee Break Tour - Jobs and Documents
Printing Setup

6.3 Selecting an Existing Job

The Finding a Job  topic shows several ways to locate and retrieve a Job onto the Main Form.

Once selected onto the form, the job will appear in gray text because you can't modify it without
choosing an Action such as Modify.

You can now perform any applicable Action on the document, such as Modify, Book Out etc.. The main
Actions are shown on the Function Bar situated at the foot of the Main Form and also under the main
Action menu.

See also
Understanding Actions
The Clear Form Action

6.4 Finding a Job

There are several ways to locate and retrieve a Job on the computer. The fastest is by using the Doc No,
also called a Job No.

To Retrieve a Job Document by Doc/Job No

Clear the Main Form if it is not already clear (F12)
Type the Doc No into Doc No box

Press Enter

The Job details should now appear on the Main Form, if not  then the Doc No.  is  invalid - use one of the
methods below to locate the job.

Sometimes you don't have the Job No.  handy,  or you are responding to a call  from a Surgery  who only
know the patient name, in which case use one of these methods.

Other methods to retrieve a Job :

By Patient name - see Patient Search
By Surgeon History
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Enter the Surgeon's name - or the first few letters of the surgeon's name - in the top of the
Surgeon Account box, and press Enter. Then press F11 (Surgeon... History) for a list of the jobs
for the surgeon in date order.
By Document List for State (Ctrl J) View... Jobs/Documents
Navigating the documents, by using the navigation arrows in the Toolbar

The arrow on the right  will  take you to the last  (most  recent) document  entered onto the system,
and then you could,  for example,  navigate backwards using  the  'back'  arrow (2nd  arrow from  the
left).

The arrow on the left will take you to the first document entered onto the system, and the 3rd arrow
will take you forward through the documents.

See also
Selecting an Existing Job
Patient Search
Understanding Actions

6.5 Modifying a Job

This guide assumes you have Transactor running with a Clear Form .

To Modify a Job

Select the job onto the Main Form (see Selecting an Existing Job )

Choose Action - Modify (F4)

Notes
If the job is not eligible to be modified it will have been Locking and Posted   If you don't want to be
bothered with the 'Are you sure you want to Modify this job?' message, you can turn this off in User
Preferences
When you have completed the changes you must choose one of the following Actions : Book In,  Book
Out,  Hold  or Delete).

See Also
Coffee Break Tour - Jobs and Documents

6.6 Booking Out a Job

Some Labs spend more time booking in the job, pricing it up etc so that when Book-Out time comes,
the job is simply retrieved and immediately booked out (F8), without modifying the details. For speedy
booking in, other labs enter minimal details and enter the rest at Book-Out time. Both techniques are
perfectly valid and Transactor is happy to accommodate them.  

For both of the above working practices, due care is absolutely essential during booking out especially
when the On-Bookout option is set to Charge. So for obvious reasons we recommend the person
assigned to booking out is not only knowledgeable, but also highly responsible.
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This guide assumes you have Transactor running with a Clear Form .

To Book Out a Job (Summary)

Retrieve the Job onto the Main Form
Edit/Modify  the Job if the details  need updating or the On-Bookout  box is  not  correctly  set  (to  either
'On-Going' or 'Charge').
Choose the Book Out action

To Book Out a Job (detailed)

Select the job  onto the Main Form

Check the job details are correct, including the On Bookout option:

On Bookout - 'On-Going'
When the Job is booked out, it will be temporary without charging. If you retrieve the job details

 during this period, the Job Status will display 'Booked Out On-Going'

On Bookout - 'Charge'
When the job is booked out. An Invoice will be generated on the system but may or may not be
printed at this point depending on your configuration  

If the job details are not correct :

Choose Action - Modify (F4)
Check and adjust the job details

Choose Action - Book Out (F8)
In the Book Out confirmation dialog, verify the pre-configured Printouts and click OK

  

Notes
The 'On Bookout' setting may have been set as part of your Booking In procedure, or you may be in the
habit of setting this during booking out. It's quicker to have this setting 'default' to your usual working
requirements. See On Bookout Options

When you choose Book Out F8, you will be prompted for your usual printing on Action requirements.
You can change these just for this time, or change the behaviour  to save time on future booking out.

See Also
Selecting an Existing Job
On Bookout Options
Printing On Confirm Action
Coffee Break Tour - Jobs and Documents
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6.7 Delivery Notes at Bookout Time

When you Book Out a Job  you will be prompted to print none, one, or several documents depending
on how your system is configured. 

By default (when you first install Transactor) you will be prompted to 'Output' a Delivery Note to the
'Batch Queue'.

What's the Batch Queue.

explain Print Manager, printing a batch. select All, then print, then they are in a Printed batch. (as
opposed to unprinted).

In essence this is the best way for a lab to print Delivery Ntoes.....
  

6.8 Deleting a Job

To Delete a Job

1. Select the job onto the Main Form (see Selecting an Existing Job ).

2. If the job is eligible to be deleted you will be able to choose Action... Delete  (or press F6).

3. In the Confirm Action  window, click Delete Job.

Transactor will will retain a record of this job being deleted but it can't be undeleted.
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Note
If the job is not eligible to be deleted it will have been Locked  or the Action is not appropriate for
some other reason.

See Also
Listing all Jobs & Other Documents
Understanding Actions

6.9 Listing all Jobs & Other Documents

All the Job Documents on the system, regardless of which Surgeon or Patient, will be viewable from this
window.

To List Jobs by Job Status

From the View Menu, choose Jobs/Documents
Choose a Job Status from the Find drop-down list

This window can list jobs and other documents grouped by their current state of :

Credit Notes
Jobs Booked In
Jobs Booked Out Charged
Jobs Booked Out Ongoing
Jobs On Hold
Payments (Authorised)
Payments (Unauthorised)  ie. not cleared
Queries Finalised
Queries On Hold
X-Deleted Documents (Doc No and Date only)

166

47

17



Basic Working Procedures 48

© 2010 Pearce & Robinson LTD, all rights reserved

Notes
This list works in the same way as most of the other lists in Transactor. You can 'drill down' and view
documents individually in detail by highlighting the line and pressing Enter or clicking View…

6.10 Do a normal Daily Backup

To Back Up Your Data

1. Insert your external storage device if you use one 

2. In Transactor, choose Exit.. from the File  menu.   

3. In the End Session window, choose the Exit Transactor and Backup data  option and then click
Yes

4. When the backup has completed, remove your external storage device

Notes
When the backup has completed, check that there are no error messages. Once you have responded to
the  instruction   Press  any  key  to  continue,  the  backup  window  should  close.  If  you  see  any  error
messages Contact Us

You should check the location of your backups is correctly set, see Configuration and Preferences - Set
Backup Location

The recommended backup storage device is a USB Flash Drive, fast and reliable just like Transactor!

See Also
Verify your data backup

7 Surgeon Accounts

The maintenance of Surgeon accounts will be key to running your business. 

See also:
Understanding Surgeons and Practices
Surgeon Reports
Coffee Break Tour
More Advanced Procedures
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7.1 Selecting a Surgeon Account

A surgeon account may be located and selected onto the Main Form in either of the following ways.

First ensure you have a Clear Form

Select by account number

1. In the Surgeon Account… box, type the account number and press Enter.

2. The surgeon account details will immediately appear on the Main Form.

Select by name

1. In the Surgeon Account… box, type all or the first few letters of the surname and press Enter.

2. The Surgeon Account Selector window will appear with a list of surgeons matching the name search
text. Highlight the account you require and click Select.

3. The surgeon account details will now appear on the Main Form.

NOTE:

See also:
Surgeon Reports
Coffee Break Tour
More Advanced Procedures

7.2 Adding a New Surgeon Account

1. In the 'Surgeon Account' box, type the surname of the new surgeon account and press Enter.

2. Check the surgeon account is not already listed in Transactor, and click 'Add new'

NOTE
With this selection window you can see if this surgeon or one with this name already has an
account. It is ok to setup two or more accounts for the same surgeon if that's what you intend. See 
Understanding Surgeons and Practices . All Dental Practices already in Transactor will be listed
in the 'Practice Selector'  window. Look for the Dental Practice from which this surgeon account will
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be working. If the practice you want is in the list highlight it and click 'Select' and go onto step 4. If
the Practice is not already listed, click 'Add new', fill in the practice name and address and click OK
to add the practice to theTransactor database.

3. In the Add New Surgeon Account  window, fill in the rest of the name
4. Click Select to associate this Surgeon with a Dental Practice. in the 'DENTAL PRACTICE' box.

4. Click Select to associate this Surgeon with a Dental Practice. in the 'DENTAL PRACTICE' box.
5. If the 'Dental Practice' address is the same as the 'Invoice Address' for this surgeon account, tick the

'Same as above' box. The practice address will automatically fill the 'Invoice Address' details. Go to
step 7. Otherwise, if the Invoice Address is different, leave the 'Same as above' box unticked and enter
the Surgeon's Invoice address.

6. Fill in the rest of the Surgeon Account details and click OK to add the new surgeon account to the
Transactor database.
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See Also

Understanding Surgeons and Practices

Tour Surgeons

7.3 Adding an Opening Balance

If a new surgeon account has an existing account balance to carry over from an old system you must
add an opening balance to the account.

To add an opening balance to a Surgeon account 

1. Select the surgeon  account onto the Main Form
2. From the Surgeon  menu, choose Payment…
3. If the balance amount is a debit (ie. An amount owed to you) go to step 5.
4. The Payment  window will initially be in Add Credit/Receipt  mode. This is correct for entering a credit

balance, select the payment method Opening Balance Credit.  go to step 6.
5. For a debit balance, switch to Debit/Refund  mode by clicking the button in the top right-hand corner

of the Payment  window. Select the payment method Opening Balance Debit.
6. Type the amount and click OK. The account balance will now show on the Main Form.

Example Opening Balance Debit (The Surgeon owes the Lab money)

This is the usual situation when you are setting up Transactor and bringing forward the Surgeon
balances. 

Example Opening Balance Credit (The Lab owes the Surgeon money)

This would be highly unusual since normally a surgeon account would be in Debit.
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7.4 Modifying a Surgeon Account

To view and/or modify surgeon account details

1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).
2. Choose View / Modify… from the Surgeon  menu. Alternatively, you can press the Enter key when the

Surgeon Account… box is highlighted or double-click the left mouse button while the mouse pointer is
hovering over the surgeon address box.

3. The Modify Surgeon Account  window appears. You are now able to adjust any details as necessary.
4. Click OK  to update the surgeon account.

See Also

Understanding Surgeons and Practices

Tour Surgeons

7.5 Viewing a Surgeon's Jobs & Payments

The Surgeon Account History window gives a complete picture of all past and present jobs and
payments for that surgeon.  From this window you can drill down onto job details, select jobs onto the
Main Form and perform several other functions available from the Right-Click menu. 

To view the Surgeon Account History

1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).
2. From the Surgeon Menu, choose History
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The Surgeon Accounts jobs and payments are listed in invoice date order. The Symbols in the Paid
column indicate the payment status. 
If the payment or job has been Locked you will not be allowed to modify or delete it. 
You can highlight any item in the list and press Enter or click View. to see more information about the
highlighted entry.

7.6 Adding a Payment to a Surgeon Account

1

To Add a Payment to a Surgeon Account

1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).
2. From the Surgeon  menu, choose Payment…
3. Choose the payment method.
4. Type the amount and any additional details.
5. Click OK  to add the payment to the surgeons' account.

Note: Directly after adding the payment, the Allocate Credit  window will appear. See Allocating a
Payment to Unpaid Invoices  

7.7 Making a Refund Payment

There will be occasions when you wish to debit  or refund a Surgeon,  for example a surgeon overpaid or
you over-charged. If you over-charged for a job, don't forget to issue a Credit Note  first.

There are two likely scenarios you may come across when dealing with Customer refunds :
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Surgeon Was Over-Charged

1. Issue a Credit Note
2. If  sending  a  cheque  to  the  Surgeon  then  in  Transactor,  make  a  Debit/Refund  Payment

Transaction, choosing 'Cheque Refund' as the Payment Method.

Surgeon Overpaid

Option A.
Leave the extra credit on account. It will be used up with future sales to this customer

Option B.
Send the (extra) money back as a refund cheque, Cash or Bank Transfer.

1. Send a cheque to the Surgeon for the Overpaid amount
2. In Transactor,  make a Debit/Refund Payment  Transaction,  choosing  'Cheque  Refund'  or  other

appropriate Payment Method.

How to Make a Debit/Refund Payment Transaction
In short, when the Surgeon details are on the Main Form, make a payment of type 'Debit/Refund' 

1. Select the surgeon  on to the Main Form. 
2. From the Surgeon menu, choose Payment
3. In the Payment window, click on 'Debit/Refund' in the top right corner. 
4. Choose a payment method from the dropdown list, the amount to refund, then click OK.

How to Choose a Debit/Refund Method

In cases where you wish to physically send the Surgeon money, choose one of these Debit/Refund
Payment Methods :

Cheque Refund
Cash Refund
Bank Transfer Debit
Card Refund
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In case where you just wish to adjust the Surgeon's account balance, choose one of these Debit/Refund
Payment Methods :

Adjustment Debit
Opening balance Debit
Write-Off Over payment Debit

The other methods are visible in the 'Payment Method' dropdown list

7.8 Deleting a Surgeon Account

You can mark a surgeon account as DELETED to stop the account being used. A DELETED account
remains on the system together with all its previous jobs and payments and may be re-instated at any
time.

To delete a surgeon account 

1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).
2. From the Surgeon menu, choose Delete..

If a deleted surgeon account is selected onto the Main Form, the word DELETED will be drawn over it.
 

To undelete a deleted surgeon account 

1. First ensure you have a Clear Form
2. From the Surgeon Menu, choose Select
3. In the Status drop-down list, choose Deleted
4. Right click the Surgeon and choose Un-Delete

Notes
You can also Undelete a Surgeon Account if it is displayed on the Main Form.  The quickest way to 
select the Surgeon  is by Account Number but you can also use the Select Account window.

To Select a Deleted Surgeon Account onto the Main Form 

1. First ensure you have a Clear Form  
2. From the Surgeon Menu, choose Select
3. In the Status drop-down list, choose Deleted
4. Highlight the Surgeon Account and Choose Select
5. From the Surgeon Menu, choose Un-Delete
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Also See
Suspending a Surgeon Account

7.9 Suspending a Surgeon Account

You can use Suspend to mark an account as 'on hold'.

To suspend a surgeon account 

1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).
2. Choose Suspend… from the Surgeon  menu.

Once a surgeon account has been SUSPENDED, it will still appear listed (as Status = normal) in the
Surgeon Account Selector  window but it will appear in RED text.

You can still select the surgeon account onto the Main Form and use it as normal but it will have the
word SUSPENDED drawn over it.

 

To un-suspend a suspended surgeon account 

1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).
2. Choose Un-Suspend… from the Surgeon  menu.

Also See
Deleting a Surgeon Account

7.10 Allocating a Payment to Unpaid Invoices

Usually Transactor automatically prompts you do Allocations after you enter a Sales Payment or
Adjustment Credit. At any other time you can use the following method.

To allocate, un-allocate or re-allocate a credit 
Locate the credit transaction in either the Surgeon Account History   window or the Jobs/
Documents  window.
Highlight the credit item and right click.
Choose Allocate Credit

All credit amounts (ie. credit payments and credit notes) on Surgeon Accounts must at some point be
allocated to specific jobs/invoices to indicate them as paid. This allocation process does not affect the
value of the credits themselves, but it affects the Aged Analysis shown on Surgeon Account statements
and Aged Debtors reports.

When allocating a credit, usually all you need to do is click Auto Apply (see bottom of 'Allocate Credit'
window). 
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This will automatically allocate the credit to the oldest unpaid invoices/jobs. Alternatively, you can
directly specify to which items to allocate the credit by highlighting them in the list and clicking Apply.

A  tick indicates a fully paid or allocated item; a half-filled box indicates a partly paid or allocated item.
The Surgeon Account History  window and the Jobs/Documents  window show the paid/allocation status
of each transaction in the 'Paid' column.

See Also 
Walk thru Payment allocation and Credit Note

7.11 Modifying or Deleting a Payment

1

To Modify or Delete a Payment:
1. Select the surgeon account onto the Main Form (see Selecting a Surgeon Account ).

2. Choose Surgeon Account History  from the Surgeon  menu.   

3. Double-Click the Payment transaction (or highlight and press Enter)

4. In the Payment window choose either Modify or Delete

If the payment has been Locked , you will not be allowed to modify or delete it. 

In the Surgeon Account History , Un-Locked transactions are in blue.

7.12 Grouping Surgeons by Profiles

How to set up Surgeon Profiles for Group Surgeons

In the Surgeon Account dialog, click Profile..
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In the Change Surgeon Account Profiles dialog, click Add New Profile..

In the Add New Profile dialog, enter an easy to type group/profile name eg. group1.
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In the main Profiles dialog, highlight your new profile name in the left window, and click Select >. 

In the Surgeon Account dialog, you should see that this Surgeon is now assigned to (a member of)
the 'group1' profile.

See also: Label Printing using Profiles and Groups

8 Products and Services

8.1 Selecting a Product/Service

The Product/Service line items are those that are predefined and stored in the database using the 
Product & Services window  and they are identified by a Code.
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To select a Product/Service onto the Main Form

1. Place the flashing cursor in the CODE.. column on a blank line on the Main Form Line-Item area.

2. Press the Enter key,  or type the first  few characters  of the  product/service  code  and  then  press
Enter.

3. From  the  Products  and  Services  window,  locate  the  product  or  service  you  require  in  the  list,
highlight it and press Enter or click Select onto form...

4. The Select  window allows you to adjust the default quantity or price. Click OK

Selection is FASTER  if you know ALL of the product/service code :

1. Place the flashing cursor in the Code..  column on a blank line on the Main Form.

2. Type the product/service code in full and press Enter.

3. The default quantity of the requested product/service item will appear on the document.

Note: For quantities  other than the default  quantity,  you can type the product/service code  followed
by a comma and the required quantity. For example:  PV,2

See also Adding a New Product/Service .

8.2 Modifying, Deleting & Inserting Line Items

Note: A document must be in Action... New or Action...  Modify mode before you can modify,  delete
or insert lines.

To modify the details of a product/service line on the Main Form

1. Highlight the line code using either the up/down arrow keys or the mouse.

2. Press the Enter key.

3. In the Modify Line  window you can change details such as quantity, price or description (depending
on the properties of the particular product/service).

4. Press Enter or click OK  to update the line details.

To delete a product/service line from the Main Form :

1. Highlight the line code using either the up/down arrow keys or the mouse.

2. Press the Delete or Del key on your keyboard.

3. A window box will pop up asking for confirmation, click Yes  to delete the line.

Note: To delete lines and bypass the Confirm Delete  window, press Ctrl Del

To insert a new product/service line between other lines on the Main Form :

1. Highlight the line where you want to insert the new line.

2. Press the insert or Ins key on your keyboard.

3. All  lines  on  and  below the  insertion  line  will  be  moved  down  and  a  blank  row  will  appear.  The
flashing cursor will be waiting on the code column.

4. You can now select a product/service onto the inserted line. See Selecting a Product/Service  
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8.3 Adding a new Line Note item

To setup a new code for new Line Note items
From the Main menu, choose Product/Service... Products and Services (Ctrl L)

In the State box, select 'Note'

Choose Add New...

Enter a representative Code and optionally, enter a pre-defined description
Unless you don't want any user to modify the description when the code is put on a Job Document,
tick the 'Can Modify Description' box

Choose Ok
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We've now setup a Code for a Pre-defined Line Note that could become part of your Quality Control
System. See Query Documents

8.4 Adding a new Product/Service

1. From the Product/Service  menu, choose Products and Services… 

2. In the Products and Services  window, click Add new… 

3. In the Add New Product/Service Item  window, type a short (up to 10 alphanumeric characters)
identification Code and a Description.

4. Enter prices for your new product or service in the appropriate price bands. You may leave prices
blank if you wish.

5. Choose a Category  which best describes your product or service. If you are not sure, choose
OTHER.

6. Click OK  to add this product or service to the Transactor database.

You can also use the Setup Wizard   to Add or Modify your Product/Service items.

 

8.5 Modifying a Product/Service

To Modify a Product/Service

From the Main Form menu, choose Product/Services
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In the Find by Code box, enter the first part of your Product Service or leave it blank.

Scroll down the list to highlight the Product/Service

Choose Properties

See also
Adding a new Product/Service  62
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You can also use the Setup Wizard   to Add or Modify your Product/Service items.

See Also
Stock Control Items

8.6 Assign technician and work units to items

This topic will show you how to configure product items so that a technician is assigned as the item is
entered onto a Job. In addition, work units per item quantity can be configured and reported on. You
should consider the benefits and disadvantages of enabling this feature.

Benefits
You can specify the number of work units per item qty
You can produce a periodical Technician Work Charged  and Technician Work Completed report
allowing you to run a work incentive bonus scheme or identify low performers.

Disadvantages
Slow data entry - takes longer to put items onto a job when booking in or out.
Data integrity - operators would have to be careful to check the correct technician has been assigned
Data integrity - when work is reassigned to a different technician the computer must be updated or it will
be incorrect
At present there is no report which can show what booked in work is assigned to what technician

If you have not already added your Technicians as Users, first read Users, Technicians and Passwords

To enable Technician work units for a Product Item

Add  or Modify  a Product/Service item
In the Properties dialog, choose More..
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Tick the Technician box
Tick the Work Required box, and enter the work units per qty one of this item
Choose Close

If you normally assign this type of item to a 'usual' technician, you can save typing later on by setting
the Preferred Technician here. It can be changed when booking in or out however there is a danger that if
the operator is not diligent, and the usual technician is on holiday for example, that the wrong technician
may be credited with the work.

To Assign a Technician to a Line item on a job being booked in or out

When booking in a job, in the Select Product/Service dialog for the line items, choose a Technician
If you are booking the job out also tick Completed.

To mark work completed

With the Job on the Main Form, and being Modified

Double click the line item.
Tick Completed

Note: Check the Technician is still correct

Also See
Technician Work Charged report   
Technician Work Completed report  
Users, Technicians and Passwords
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8.7 Changing Prices of a Product/Service

1. From the Product/Service  menu, choose Products and Services… 

2. Locate and highlight the product or service in the list.

3. Click the Properties… button.

4. In the Product/Service Item Properties  window, edit the desired price or prices.

5. Click OK  to update the product or service.

You can also use the Setup Wizard  to change Product/Service prices.

8.8 Deleting a Product/Service

1. From the Product/Service  menu, choose Products and Services… 

2. Locate and highlight the product or service in the list.

3. Right-click the product/service line using the mouse and choose Delete… from the popup menu.

4. Click Yes  in the Delete Product/Service  window. Note: This will only succeed if this product or
service has not been used on any jobs/documents. 

See Also Making a Product/Service Obsolete  

You can also use the Setup Wizard   to Add, Modify or Delete your Product/Service items.

8.9 Making a Product/Service Obsolete

Occasionally,  you may want  to discontinue a particular product/service and  because  it  has  already
been used on previous jobs Transactor will  not  allow you to delete it  completely.  The  answer  is  to
set  its  status  to  obsolete,  this  removes  it  from  the  normal  selection  list  and  hides  it  away  in  an
obsolete list. The advantages of this are that you can easily look up old products and services and re-
instate them at any time.

To make a product/service obsolete:

1. From the 'Product/Service' menu, choose 'Products and Services' 

2. Locate and highlight the product or service in the list.

3. Right-click the product/service line and choose Make Obsolete... from the popup menu.

4. Choose Yes to confirm.
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The Selected Item will not be visible in the 'Sales Item' list anymore..

To make the Code 'Not Obsolete' we need to display Obsolete items in the list.

1. In the Products and Services form, set the State box to 'Obsolete'
2. Right click the Obsolete Item in the list and Choose 'Make Not Obsolete'

See Also Deleting a Product/Service  

8.10 Renaming a Product/Service Code

1. From the Product/Service  menu, choose Products and Services… 

2. Locate and highlight the product or service in the list.

66
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3. Right-click the product/service line using the mouse and choose Rename Code… from the popup
menu.

4. In the Rename Product/Service Code  window; type your new code into the Rename to  box and
then click OK.

8.11 Stock Control Items

Some Products will be appropriate for keeping track of via Stock Control, for example Precious Metal, or
Equipment.

To Setup A Product for Stock Control

In the Product/Service Properties  window, choose 'More'

Tick Stock Control
Enter a Re-order level if required

You cannot enter a Qty In Stock at this point. We'll do that next.

TIP
It may be appropriate to enter the Units in brackets after the description eg (Grams)

To Add or Adjust Qty In Stock
In the Product/Service Properties  window, right click the Product and Choose Stock In/Out
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Enter a Quantity. 50 will put 50 in stock, - 50 will take 50 out

9 Special Job Types

This section shows you how to add :

Credit Notes  and

Query Documents

9.1 Credit Notes

Occasionally, you may need to credit  a surgeon for,  for example,  a disputed job that  was previously
charged and invoiced to his/her account.

To issue a Credit Note for a previous job:
1. Select the job onto the Main Form (see Selecting an Existing Job ).

69

70

43



Special Job Types 70

© 2010 Pearce & Robinson LTD, all rights reserved

2. Choose Action... Copy to New…

3. In  the  Copy to  New Document   window,  select  'Credit  Note'  for  the  Document  Type,  click  New
Document.

4. The form changes colour to RED, details  are copied from the original document  and then  you  can
make any changes you need to.

5. When you have finished editing, choose Action... Finalise…

6. In the Finalise Credit Note  window, click OK.

7. Allocate the credit amount to unpaid invoices (see below).

Alternatively, you can start a Credit Note from scratch:
1. Choose New Credit Note  from the Action  menu.

2. Select a surgeon account onto the Main Form (see Selecting a Surgeon Account ).

3. Add the necessary product/service lines.

4. Choose Action... Finalise…

5. In the Confirm Action  window, click OK.

6. Allocate the credit amount to unpaid invoices (see below).

After adding or modifying a Credit Note you can allocate the credit amount to unpaid invoices.

To allocate a Credit Note to unpaid invoices:
1. Locate the Credit  Note in the Surgeon Account  History  or Jobs/Documents  list  - without  bringing

the document onto the screen - (see Viewing a Surgeons' Jobs & Payments  or Listing Jobs &
Other Documents ).

2. Right  mouse click  the Credit  Note line and choose Allocate Credit…  from the popup menu (see
Allocating a Payment to Unpaid Invoices ).

3. You can then either :

 choose from the list the original document to which the Credit Note refers and click Apply,
or :

click AutoApply which will apply the credit to the earliest unpaid job for the Surgeon

9.2 Query Documents

Query  documents  may  be  used  for  recording  queries,  complaints  or  any  other  significant
correspondence with your surgeons.  Queries  are similar to Job documents  except  that  they have no
value.  They  are  stored  chronologically  in  the  surgeon  account  history  and  therefore  can  easily  be
viewed and printed etc.

To add a Query :
1. Choose New Query  from the Action  menu. The Main Form changes to a non-financial version of the

job form.

2. Select a surgeon account onto the Main Form (see Selecting a Surgeon Account ).

3. Queries only allow you to add product/service notes (which have no financial value). You can add up
to 128 lines onto the document.

4. The Query can be put on Hold (if you expect to add to it later) or Finalised. Choose either Hold… or
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Finalise… from the Action  menu.

5. In the Confirm Action  window, click OK.

More on Query Documents
Query Documents give you the ability to implement a quality control system on your customer services.

To Implement A Quality Control System on your Customer Services :
Plan out what Codes you want to use for recording the various Customer Service issues. 

We recommend keeping it simple with something along the lines of four 'Q' codes

QC1 Customer complaint

QC1_Res  Result/Resolution of customer complaint 

QE1 Customer enquiry

QE1_Res  Result/Resolution of customer enquiry

Use the Products and Services window to setup your 'Q' codes. See Adding a new Line Note item

When a customer makes an enquiry or complain you wish to track, start a new query then

Type 'Q' into the Code box and press Enter

Choose an appropriate Query Code and enter the description
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If the query or complaint has a result/resolution now, add a line item with the appropriate 'Q' code and
choose Action...Finalise.

If the query or complain is to be resolved later, choose Action... Hold.

To Monitor or Finalise Active (Unresolved) Queries
From the View menu choose Jobs/Documents

In the Find box, select 'Queries on Hold'
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Select the appropriate Document row and choose View...

If you wish to resolve and finalise the Query

In the View window, choose Select Onto Form...

Choose Action... Modify

Add a line item with the appropriate 'Q' code and choose Action... Finalise.

10 Reports and Printing

10.1 Running a Report

Reports are run from the Reports menu. They can be displayed in a Preview Window or sent directly to a
printer.

To Run a Report

From the Reports Menu choose a report from one of the report groups
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The Reports menu has been divided up into 5 Sections :

General Reports
Jobs
Practice Reports
Products & Services
Surgeon Reports
Technician Reports

In the Report Options window, select your report Options, these will vary depending on the report.
If you want to alter the underlying Properties of the report such as Page size, click Change
Choose an Output destination for the report, this is pre-set to display in a Preview Window on-screen,
from where it can be printed if required. You can also choose to output direct to a printer if you wish.

Printing an example report: Price List

From the Reports  menu choose Products & Services - Price List
In the Report  window, select your report Options, these will vary depending on the report.
Choose the 'Preview Window' Output destination for the report, from where it can be printed if required.
You can also choose to output direct to a printer if you wish.

10.2 Printing On Confirm Action

On some actions such as Book Out Charge you may want certain documents printed automatically, an
Invoice perhaps. The printing behaviour can be configured so that one or more documents are
automatically prompted to be printed whenever you choose an Action such as Book In or Book Out.

To Setup Printing behaviour on Confirm Action

In the Main Form, from the Tools Menu choose Printing Setup - Printing on Confirm Action

You can pre-set the way Transactor handles the usual printing of job tickets, delivery notes, credit notes,
invoices and queries when you perform an Action.

The Print on Confirm Action window automatically uses the default printing behaviour according to the
Action being performed and the state of the Job. 
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For example say you want Transactor to automatically print these documents on certain Actions.

On Action Book-In Print a Job Ticket direct to printer.

On Action Book-Out Charge (and Reprint) :  Produce an Invoice to the Preview Window

On Action Finalise Credit Note (and Reprint) :  Produce a Credit Note to Preview WIndow

On Actions Book-Out  On-Going,  Book-Out  Charge and Reprint  :  Produce a Despatch Note onto
the batch queue for printing via the Print  Manager  (so that  one delivery  note per Practice can
be produced after a booking out session of several jobs).

The Usual Printing when Actioning Window would be setup like this.

Note that we havn't ticked any boxes in the 'Print Document' column. Why is this? 

Action Print Document explained

106
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When we choose the Print  Action,  we may want  to choose a document  to Print  Out,  rather than be
presented with a whole bunch of pre-selected documents.  So  leave  the  Print  Document  column  (in
the Printing Setup - Printing on Confirm Action dialog) un-ticked.

When you choose the Print Action (from the Action menu,  or from the tool bar Printer Icon),  you can
select what documents you want printed at the time..

Simply choose a Document Type and printer channel to suit..

Of course if your business rules dictate that you are going to usually print a certain document 'on
demand' each time you choose Print Document, then you will want to tick the appropriate box(es) in the
Print Document column in the Printing Setup - Printing on Confirm Action dialog.

10.3 Creating A Letterhead

There are two stages to creating your own letterhead.

1. Create your Letterhead

You will  need to create your letterhead and save  it  in  .wmf or  .bmp   format.  For  best  results  ask  the
person  creating  your  graphic  to  use  a  quality  resolution  of  at  least  300  dpi  and  to  the  correct
dimensions.

Important: The file name of your graphic should be no longer than 8 characters and contain no spaces
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Copy the graphic file to c:\tran61\lab\exe (or wherever else you have installed Transactor).

example:

C:\tran61\lab\exe\logo1.bmp
C:\tran61\lab\exe\OurLogo2.wmf

2. Incorporate your Letterhead into Transactor

Click on Tools...  Printing Setup...  Printout  Type Properties.  In the Print  Type drop down box select  the
document or report you would like to modify.

If your logo graphic includes the the lab name and address then under Print  Options  uncheck ‘Your Lab
Name and Address'.
You now need to insert your logo: Under the Pictures option enter the file name and extension and insert
the x and y co-ordinates. These are 0.01mm so 200 = 2cm. Experiment  with the graphic  positioning by
closing the Printout Type Properties dialog and previewing your document.

Repeat  this  for  all  the  documents  and  reports  you  want  to  change.  Click  on  Close  when  you  have
finished.

10.4 General Reports

Analysis by Category

You would normally print this off at the end of each month and hand it to your book-keeper. See 
Accounts Reports

Accounts Receivable

This Accounts Receivable report lists payments in a period, grouped by Payment Method. See
Accounts Reports

Log History

This is a chronological list of events.
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Audit Trail

This report lists all transactions in chronological order. See Accounts Reports

10.5 Jobs

Booked in Jobs - by Due Date
This is effectively you lab's job scheduler report. In the options, leave the Due Date blank and click Ok.

All the jobs booked into you lab are listed, grouped by Due Date. The list is in Due Date order so the
most urgent jobs are at the top.

162
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Some labs run this report every day, specifying the next day's date, thereby getting printout of all the
jobs due back tomorrow.

Booked in Jobs - on Book in date
Lists a summary of each job booked in on the given date

Booked in Items
Lists line item details of each booked in job for the given Due Date.

Booked in Items Summary
Lists item totals in tabular format, for each sales category and Due Date.



Reports and Printing 80

© 2010 Pearce & Robinson LTD, all rights reserved

Booked out jobs - on going
Lists jobs that are booked out of the lab 'On-Going' therefor not charged. The report is in date order so
older jobs can be identified which have not been returned to the lab in a reasonable time for completing. 

Jobs by Due Date
Lists all jobs for the given Due Date regardless of the Job State. There is a column showing whether
each job is Booked In, Out On-going or Charged.

10.6 Printing reports or labels using Profile Groups

To print labels or another report where you are able to enter a Profile name instead of an account no.

Simply enter the group's profile name instead of the Surgeon A/c no.
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In this example there are two surgeons in this group.

See Also:
Surgeon Profiles

10.7 Patient Statements

Transactor has the ability to print a 'Patient Statement' which conforms with the MDD 93/42/EC with
minimum fuss. 

If your system has already been configured for printing your labs Patient Statements, skip now to 
Printing Patient Statements

If your jobs don't get outsourced to Non-EU labs, you don't need to do anything other than print the
Patient Statement. Just see  Patient Statements Set Up   on how to make your template look the
way you want it. This 'default' Patient Statement will contain the simple declaration "..the complete
appliance has been wholly manufactured within the EU".
If some or all of your jobs get outsourced to Non-EU labs, then you need to Setting up Manufacturing
Location Origin codes   to carry the manufacturing locations, and the appropriate ORIGIN code(s)
added to the relevant job.

Origin of Manufacture
The statement must declare either "..the complete appliance has been wholly manufactured within the
EU", or "..not been.." in which case the manufacturing locations must be listed. 

By default Transactor will print a Patient Statement with the simple "All within EU" declaration.  However
if ORIGIN1 or ORIGIN2 codes are found on the job, Transactor will automatically replace this with the
"non EU" statement and print the list of manufacturers. 
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If a lab normally out-sources work to outside the EU then Transactor can be setup to include ORIGIN
codes automatically on each job thus saving tedious data entry. If a lab always needs to declare non-EU
manufacturing locations, then it may change the background image of the template to contain the
required information so that ORIGIN codes don't need to be used.

A4 and A5 Templates
There are 2 templates to choose from. A4 and A5. Both can cater for the simple case (All within EU)
or multiple non-EU manufacturing locations. 
The A4 template has space for up to 3 manufacturing locations in the bottom area. 
The A5 statement is more compact with space for up to 2 manufacturing locations.
The Origin Declaration text can be customised.
The background image for the form, the other form text, labels and the company logo, can be replaced
with the lab's own images.
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Also See:
Patient Statements Set Up
Printing Patient Statements
MHRA document "Guidance to Changes to the Medical Devices Directive 93/42/EC with respect to
custom-made devices statements"

Terms:
MHRA: Medicines and Healthcare products Regulatory Agency
MD Directive: Medical Devices Directive. The Medical Devices Directive covers the regulatory
requirements of the European Union for Medical Devices.

 

10.7.1 Patient Statements Set Up

This topic will guide you through setting up an A4 Patient Statement. 

To invoke the Printout Type Properties for the Patient Statement

From the Tools menu, choose Printing Setup - Printout Type Properties
In Printout Type, choose Patient Statement (A4)..  (or A5)
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To change the Declaration Statement

In the Printout Type Properties
Change the text in the Message area
Choose Close

There are two messages encoded in this box. By default a Patient Statement will be printed with the first
simple "All within EU" declaration. This is the text before the  ̂Divider  as shown in the above image. 

The second "non-EU" message is the one Transactor will print if ORIGIN1 or ORIGIN2 codes are found
on the job, along the list of manufacturers. NB: even if your lab currently does not out-source outside the
EU, you can leave this second message intact, it just won't be used. See below.

To change the company logo

Preparation
place your company's logo image file into the C:\tran61\lab\exe folder on your PC. The file type must be
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either bitmap (.BMP) or Windows Meta File (.WMF). The filename must be less than 8 characters with
no spaces so for simplicity rename your file to logo.bmp or logo.wmf. The image should have been
supplied by your graphics designer as a high quality graphic to the correct intended size. With the
correct logo file you should have pin-sharp printouts indistinguishable from pre-printed stationery. 

In the Printout Type Properties
In the Pictures group box, enter the logo's file name (eg. Logo.bmp) into the box below the one
containing PForm.wmf.
Enter approximate X and Y position pixel values (about 100 = 1CM) from the top left of the paper to the
top left of the logo. You will need to experiment to get this right. 
Choose Close

Print a Patient statement to the Preview Window to see your logo's positioning and go back to Printout
Type Properties to adjust your X and Y values until correct. 

To add or change the background image

Preparation
The default image (PForm.wmf) is already located in in the C:\tran61\lab\exe folder on your PC. Your
graphics designer may modify this or produce another. The file type must be either bitmap (.BMP) or
Windows Meta File (.WMF). The filename must be less than 8 characters with no spaces so for
simplicity rename your file to PForm2.bmp or PForm2.wmf. The image should have been supplied by
your graphics designer as a high quality graphic to the correct intended size.

In the Printout Type Properties
In the Pictures group box, enter the new background image file name (eg. PForm2.bmp) into the upper
box currently containing PForm.wmf.
Choose Close

Print a Patient statement to the Preview Window to see your new background image's positioning and
go back to Printout Type Properties to adjust your X and Y values until correct.

To configure printing a Patient Statement automatically on Book Out

From the Tools Menu, choose Printing Setup - Printing on Confirm Action
Add Patient Statement (A4 or A5) to the Printout Type list 
On the required check boxes in the correct row and choose the Output and number of copies.
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Click Close
When you book a job out in future, you will be automatically prompted to print a Patient Statement

Also See: 
Setting up Manufacturing Location Origin codes
Printing Patient Statements

10.7.2 Setting up Manufacturing Location Origin codes

If your lab uses other Non-EU laboratories for all or part of the manufacturing process, then these need
to be listed on the Patient Statement for the job that it concerns.

This is done by adding a product lineitem onto the job, with a code of ORIGIN1 or ORIGIN2 etc. Each
manufacturer must have an individual origin code. The presence of an ORIGIN code on the job will signal
Transactor to use the Non-EU declaration and list the manufacturers on the Patient Statement.

To add or change Origin codes for other Manufacturing locations

On a Main Form, blank or a job being modified, click in the Code column and press ENTER.
In the Products and Services dialog, in the 'Find by Code' box, enter ORIGIN1
In the State box, choose NOTE
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Note: If ORIGIN1 already exists this will be listed so just right click it, choose Properties and check the
details are correct, then skip the rest of this topic.

Click 'Add New'
Enter the manufacturing location (name and short address). There are limited characters so you may
need to abbreviate*
Choose OK and then Select Onto Form (to verify it looks ok on the form).

That's it. You now have the ability to 'register' other 'Non-EU' manufacturing locations have been involved
with the Job and your Patient Statement will reflect this fact. By the way, the ORIGIN codes you see on
Transactor's Main Form won't be printed in the items area of the Patient Statement. Transactor picks up
these details and puts them neatly into your Declaration List. Clever stuff don't you think. See Printing
Patient Statements  for a example print out.

There's more things you can do to optimize your process and save repetitive typing. You can decide
whether to manually add the ORIGIN product code onto Jobs as and when required, or to setup Jobs so
that one or more ORIGIN codes are automatically on new jobs. See New Document Setup

10.7.3 Printing Patient Statements

To Print a Patient Statement

87
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On a Main Form, select a previously Booked Out job
Click the Printer Icon on the Tool Bar, or choose Action - Print (F5) 

In the Output group, choose Patient Statement (A4) or (A5) to Printer or Preview.

 

To Print a Patient Statement automatically on Book Out

This assumes you have set up printing on confirm action. See Patient Statements Set Up

On a Main Form, select a previously Booked Out job
Click the Printer Icon on the Tool Bar, or choose Action - Print (F5) 
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To Print a Patient Statement with Non-EU Manufacturing Locations

This assumes you have set up one or more ORIGIN codes. See Setting up Manufacturing Location
Origin codes

On a Job being modified, in a blank row in the lineitem area, enter ORIGIN1 in the code column and
press ENTER

Book out the job as usual
In the Confirm Action dialog, in the Output group ensure Patient Statement (A4 or A5) is selected as
one of the documents to be printed
Choose OK
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By the way, the ORIGIN codes you see on Transactor's Main Form won't be printed in the items area of
the Patient Statement. Transactor picks up these details and puts them neatly into your Declaration
List. Clever stuff don't you think. See Printing Patient Statements  for a example print out.

There's more things you can do to optimize your process and save repetitive typing. You can decide
whether to manually add the ORIGIN product code onto Jobs as and when required, or to setup Jobs so
that one or more ORIGIN codes are automatically on new jobs. See New Document Setup

87

151



Transactor Dental Lab91

© 2010 Pearce & Robinson LTD, all rights reserved

10.8 Practice Reports

Practices Address labels
This report can print standard labels of various formats for one or more of your Practices. Also See : 
Label Printing Setup Options

If you are using a full sheet of labels, click Ok. Otherwise change the Start Row or Start Column before
clicking Ok.

102
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Delivery Notes By Due Date
This report produces a list of Delivery Notes from a Due Date specified by you. The report lists Surgeon,
Document, Patient & a Description of the item(s).

Practice Summary (date range)
This report produces a summary list  of invoices per Dental Practice.  You can choose Invoice Totals  or
Statement  Balances,  and you will  need to provide a date range.  The system automatically  suggests  a
'To' date of today's date, and a 'From' date of 2 weeks ago, but you may want to choose your own dates.
 

Practice Summary (monthly)
This report produces a monthly summary per Dental Practice. You can choose Monthly Invoice Totals  or
 Statement Balances, and you will need to provide a month and a year.

10.9 Products & Services

Price List
This report lists the products and services your lab provides. You can sort by Code, Description or
Description Excluding Code. The example shown below is sorted by Code.
You may also choose up to 3 types of Price Bands to list. Different Price Bands are created on the
'Price Bands' screen of the Setup Wizard. The Example Company has 3 price bands set up as
examples : NHS, Private and Independent.

Products and Services
This report lists Products and Services. The report can be sorted in Code or Description order. You can
include 3 types of Products and Services - All, Stock Controlled or ReOrder Info only.
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Products and Services Sales
This report lists - in Code order - the quantity and value of Products & Services between two dates. You
need to provide a 'From' date and a 'To' date for the report.

10.10 Surgeon Reports

Surgeons - Address Labels
This report can print standard labels of various formats for one or more Surgeons. See Label Printing
Setup Options
If you are using a full sheet of labels, click Ok. Otherwise change the Start Row or Start Column before
clicking Ok. 

Aged Debtors
This report lists debtors in Account Number order.

Sales Totals (date range)
This report lists Surgeon Name & Account Number, Job Number, Credit Note Number & Total Sales.
You need to tell the report a 'From' date and a 'To' date. The system automatically suggests a 'To' date
of today's date, and a 'From' date of two weeks ago. You can of course change these dates.
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Statement (date range) see Statements

Statement (monthly) see Statements

Statement (unpaid invoices)  see Statements

Summary Invoice (monthly) see Summary Invoices

Summary Invoice (date range) see Summary Invoices

Telephone numbers
This report lists Surgeon Name & Account Number, Practice & Telephone Number.
If you choose Surgeon Type of All Types, the Surgeons are listed alphabetically
A Surgeon Type of Surgeon is only applicable if you have set up different types of Surgeon in the Setup
Wizard  (see the Surgeon Types) screen. When Surgeon is selected as Surgeon Type, Surgeons are
listed alphabetically within Surgeon Type.

10.10.1 Statements

There are 3 statement reports. All can produce statements for either a specified surgeon account or all
surgeon accounts. The ideal time to produce statements to send out to surgeons is after you have
completed your last Booking Out for the month. Alternatively, you can run off statements for previous
months at any time.

Statement (monthly)
This lists all jobs (charged for) and payments (paid in) within the specified one month period with a
balance brought forward and aged debt analysis. 
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Statement (Date Range)
Similar to the Statement (Monthly) but lists all jobs (charged for) and payments (paid in) within the
specified date period with a balance brought forward and aged debt analysis.

Statement (Unpaid Invoices)
This Statement shows all unpaid invoices for 1 or more surgeons. With line item details below the
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Patient.

See also
Walk thru end of month Statement and Posting

10.10.2 Summary Invoices

This report summarises invoices for a specified surgeon account  and month period with a grand total
amount. 'Summary Invoice' reports  are given a reference number made up from the surgeon account
number, month and year.

Choose Surgeon Summary Invoice  from the Reports  menu.

181
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10.11 Technician Reports

The  Technician Work Completed and Technician Work Charged are very similar.

The difference is the method of selection.

Technician Work Completed
Selects work that is marked as Completed in the Product/Services Properties. 
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To See the Technician and Completed boxes in a given Product/Service properties, use the MORE
button in the Product/Service Properties. See Products page in the Setup Wizard.

Technician Work Charged
Selects work on a Job that has been Booked Out and Charged for during the date range.

Also See
Users, Technicians and Passwords
Assign technician and work units to items

10.12 Printing a Job Ticket

If your lab uses Job tickets, Transactor should be set up to print a Job Ticket on action Book-In. 

To change how Job Tickets and other documents are automatically printed see Printing Setup  

To manually print a Job Ticket at any time

With the Job showing on the Main Form, from the Action menu, choose Action Print or click the
Printer Icon on the Toolbar.

Note that the job must be in a Booked In or a Booked Out state, otherwise you have to action the Job
First. See Booking In a Job , Booking Out a Job
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10.13 Printing Delivery Notes

When you Book Out  jobs,  Transactor can optionally  print  delivery  notes  (and invoices for Book Out
Charge). See Printing Setup

Delivery  notes  can  be  printed  singularly  (Printout  Type  =  Delivery  Note),  in  which  case  you  get
details of 1 job going to 1 surgeon at his/her dental practice.

Delivery notes can also be printed 'grouped' (Printout Type = Delivery Note to Practice). This means
that all deliveries going to surgeons working at a particular dental practice are printed together on one
sheet, which saves paper and makes it easier for your delivery driver.

To produce 'grouped' delivery notes :

1. When  Booking  Out  jobs,  output  all  Delivery  Note  to  Practice  printout  requests  to  the  Batch
Queue, NOT direct to a printer.

2. At the end of a booking out session, call up Print Manager… from the Tools  menu.

3. Select All  un-printed Delivery Note to Practice printouts and click Print…

4. Choose where you want them printed. Your delivery notes will be 'grouped' as shown in the example
printout.

See Also
Coffee Break Tour - Printing a daily report

10.14 Printing Surgeon address labels

Label reports are very useful for printing address labels for mailings or internal administration.

The reports will print out of the box to standard address labels on A4 Lazer/inkjet label sheets, 14 to a
page as per J8163/L7163 or STAP14 from Staples stationers. If you have different label sizes or page
format you will need to Change the Properties.

How to print Surgeon Address Labels for many Surgeons

From the Reports menu, choose Surgeons - Address Labels

In the Surgeon A/c no box, either leave it blank (all) or enter a Surgeon Profile  (for a group of
surgeons)

If you are using a new sheet of labels leave Start row and Start column set to 1
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If you want each sheet of labels to be repeated, set the number of copies. With these settings this is
the equivalent of stating how many labels you want repeated for each address.
Click Ok to Preview your labels

or specify the account number and print whole sheets of the same address
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How to print Surgeon Address Labels for one Surgeons

Follow the same procedure as 'How to print Surgeon Address Labels for many Surgeons' but enter the
Surgeon A/c number. This will produce a whole sheet of labels for the same Surgeon. You may also
choose the number of copies (pages) you require.

Changing label Printing Options

This example uses the Practices Address Labels report as an example.

From the Reports menu, choose Practices - Address labels

Click Change
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This graphic highlights the main things you need to change to print to a different label format. Before
changing your settings, note down your current ones (highlighted in yellow above) so you will be able to
see how your changes affect your label report. 

Contact Us  for advice on how to set these for your type of labels.

10.15 Printing Practice address lablels

Label reports are very useful for printing address labels for mailings or internal administration.

The reports will print out of the box to standard address labels on A4 Lazer/inkjet label sheets, 14 to a
page as per J8163/L7163 or STAP14 from Staples stationers. If you have different label sizes or page
format you will need to Change the Properties.

Printing labels for all Practices

This is similar to the procedure for How to print Surgeon Address Labels for many Surgeons   however
you must leave the Practice No blank as you can't use Profile Groups to restrict the set. 

From the Reports menu, choose Practices - Address Labels
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Leave the Practice no (for repeats) box clear

If you want each sheet of labels to be repeated, set the number of copies. With these settings this is
the equivalent of stating how many labels you want repeated for each address.
Choose Ok

Printing labels for one Practice

Follow the same procedure as 'Printing Labels for all practices' but enter the Practice number. This will
produce a whole sheet of labels for the same Practice. You may also choose the number of copies
(pages) you require.

You will need a Practice No which is not immediately obvious, in fact it's kind of hidden but we'll give you
two ways to get the Practice Number first. Practice numbers are all negative so remember that minus
sign when using this number in the Practice label report or you'll get no labels.

Obtaining the practice number for a practice.

    * Select the Surgeon onto Transactor's Main Form

    * Double click the Surgeon address box to bring up the Surgeon Record

    * In the Dental Practice box, choose Change

    * In the Change Dental Practice box, choose View/Modify Dental Practice

    * In the Caption of the Modify Dental Practice box you will see the Practice Account No. eg. Modify
Dental Practice -69

Obtaining a list of Practices with all the Practice numbers
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    * From the Tools menu, choose Export Data

    * In the Data Records box, choose Practices

    * Choose Export to File

    * In the File name box enter PRACT, in the Folders box choose a folder you are familiar with eg C:
tran61

    * Choose Ok

    * In My Computer, or Windows Explorer, locate the file PRACT.CSV, open it and print it out.

    * This Comma Separated text file contains a list of all your practices, the Practice No (In the First
column under CustID)

11 Tools

11.1 Patient Search

To locate jobs by patient name :

1. Choose Patient Search… from the Tools  menu.  

 

2. In the Patient Search  window, type all or the first part of the patient's surname and press Enter or
click Find.

All jobs with patient names matching your search text are listed.

Once you have a list  of  jobs,  you  can  view any  job  by  highlighting  the  line  and  pressing  Enter  or
clicking View…  With the job in the mini-viewer you either choose Close or Select  to retrieve the job
onto the Main Form.

11.2 Locking and Posting Jobs

Jobs  and  payment  transactions  are  initially  marked  as  'not  locked'  what  is  also  called  'un-posted'.
Transactor will allow you to Modify these. You should periodically perform a Locking operation to mark
all eligible documents (up to a specified date) as Un-Locked/Posted.

To do a Posting :
1. From the Tools menu, choose Lock Finished Documents..
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2. Set the 'Lock documents dated up to' date and click Refresh

3. Choose Do Posting

More about posting
Locked/Posted documents are permanently finished and unmodifiable but you will still be able to view
them. 

Locking/Posting may be done at any time but a typical lab would do it after the end-of-month
Statements and Invoices have been verified.

To display Locked Jobs :
Locked jobs and payments are still visible in lists just as before, and can still be selected onto the Main
Form for viewing.

In the Surgeon History list, Locked items are displayed in black. See Viewing a Surgeon's Jobs &
Payments

Note: If you need to correct a job/invoice that has been Locked, you will have to issue a Credit Note
to cancel the value of the incorrect invoice and then issue a new invoice (ie. by starting a new job and
immediately Booking it out as charged).

Questions about Posting

How often should I perform a Locking?
We recommend you do this  a few days after your monthly  statements  are  sent  out,  and  set
the ‘Post documents dated up to’ date to the end of the previous month.  Doing things this  way
you get  the best  of both worlds;  you get  a chance to  get  feedback  from  the  statements  and
save  work  by  making  adjustments,  and  protect  older  job  documents  from  unwanted
modifications.

If you booked a job and charged for it, can you still bring it back and modify the details? 
It  depends on  the  circumstances.  The  answer  is  'yes'  if  you’ve  just  booked  the  job  out  and
haven’t  performed an end-of-month Posting.  Transactor will  warn you though,  because if  you
printed an invoice and sent  it,  you should discuss the changes with the surgeon and re-issue
that  Invoice.  The answer would be 'no' if an ‘End-of-Month’  Posting  has  been  performed.  See
next question.

I have a job which is charged. It’s for the wrong amount and it's Locked so I can’t modify it. What can I
do?

Follow standard accounting practice by issuing a credit note  against it. Then do a new one.
You can save work by using the ‘Action – New Credit’ note’ menu item when the erroneous job
is on the Main Form.

What happens if i never do a Locking?
Eventually, the Surgeon History  window will  reach its  limit  for displaying un-Locked 'blue' jobs
(approximately  300  for  each  surgeon)  at  which  point  you  will  be  warned  that  a  Posting  is
overdue.  If this  limit  is  reached your data  is  not  at  risk  and  you  can  continue  booking  in  an
unlimited number of new jobs. It is only the History Display which is temporarily affected.
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11.3 Print Manager

Print Manager handles  printout  requests  outputted to the  Batch  Queue.  For  example,  when  jobs
are booked in or out, printout requests (for job tickets, delivery notes, invoices etc) may be directed to
a Batch Queue instead of a real printer.

All printout requests sent  to the Batch Queue  will  be listed in Print  Manager (initially  as  unprinted).
You can call up Print Manager, list unprinted or previously printed batches and output them direct to a
printer for printing.

Choose Print Manager… from the Tools  menu.

 
There are 3 View  options :

Un-Printed Batches - Shows printout requests outputted to the batch queue which have not been
printed yet.

Printed Batches - Previously printed printout requests.

Un-Printed (Direct to printers) - Printout requests outputted for printing but not completed because
of a printer error.

11.4 Utilities

If in doubt about using any of these utilities, contact technical support use.

Choose Utilities… from the Tools  menu.

Print Server Is Busy

If you ever get the message Print Server is Busy you can clear it from this utilities window.
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Also, you can :

Un-Post all Locked transactions.

Re-generate the paid/allocation indicators.

Clear Database.

This  is  useful if you have been trying out  Transactor with some test  jobs within  the  trial  period
and you have finally decided to use Transactor for real.  You can optionally  clear/reset  the whole
database or just delete the jobs and keep the Practices, Surgeon and Products intact.

11.5 Backing Up & Restoring Your Data

To Back Up Your Data
Insert your external storage device if you use one 
In Transactor, choose Exit.. from the File  menu.   
In the End Session window, choose the Exit Transactor and Backup data..  option and then click Yes
When the backup has completed, remove your external storage device

Notes
When the backup has completed, check that there are no error messages. One you have responded to
the instruction  Press any key to continue, the backup window should close. If you see any error
messages Contact Us

You should check the location of your backups is correctly set, see Configuration and Preferences - Set
Backup Location

See also
Configuration and Preferences - Maintenance Menu

More about Backups

A  data  backup  can  backup  your  Transactor  Database  to  your  computer's  hard  disc  drive  or  to
external storage device such as  USB memory stick.  A  modern  USB  memory  stick  can  hold  many
backups and are inexpensive enough to have several in rotation.

The reason for doing regular backups is  to guard against  the chance of your computer  developing  a
hardware fault, becoming contaminated with a computer virus  or even someone accidentally  deleting
files.

Backup Strategy
A simple data backup strategy you could consider would be using several External Storage Devices
such as a USB memory stick. Label one Daily and the other Weekly.

Daily : 
Insert the 'Daily'  Memory Stick then back up as normal when exiting Transactor
Weekly: 
Insert  the 'Weekly' Memory  Stick  then back up as  normal  when  exiting  Transactor,  then  keep
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that Memory Stick separate and in a safe off-site location for the next week.
Monthly:
After doing your weekly back up, store away the Weekly  Memory  Stick  for a month,  substituting
with another. 

Periodically, say a few times a year,  you should delete the older backup files  to save your computer
or your removable storage device becoming cluttered up.

N.B. Always leave the backups which are dated in the last month or so.

To Restore Your Data

Warning

Improper use of the Maintenance Menu facilities could damage your Transactor data.  Contact  Us
if you are not trained with this facility.

1. Insert your external storage device if you use one 

2. Close Transactor if is running

3. Select Start... All Programs... Transactor v6.1... Maintenance Menu

4. Choose 'Restore from Backup'

You will be prompted to tell Transactor where the location of the backup is. The location will default to
c:\tran61\lab\live\data (unless you have already changed this by using the 'Set Database Location'
option).

11.6 Export Data

Use this tool for exporting data to your Spreadsheet tool for printing custom reports, address Labels ,
mail-merge letters, or product lists etc

To Export Data to a CSV file suitable for your Spread-Sheet tool

In the Main Form, from the Tools menu, choose Export Data

Choose the required type from the Data Records list box

185
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Enter a File name of upto 8 characters
Choose a file Type of CSV (Comma Separated Values) suitable for opening in your Spreadsheet tool (eg
Open Office or MS Excel)
Choose an appropriate Folder and click OK

Your file can now be opening in your favorite Spreadsheet tool as follows. The example uses Open Office
which i prefer over Microsoft's Excel (and it's free from http://www.openoffice.org ).

To open your exported data in Open Office
Open Windows Explorer and navigate to your file location folder
Right Click your CSV file and choose Open With - OpenOffice...

Open Office (or your chosen Spreadsheet tool) will prompt you to confirm which columns you want, it's
easier to accept it as it is for the moment.

Choose Ok to accept the Text Import options
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In the Spreadsheet tool you can manipulate the columns and prepare the data for your own in-house
reports or sales literature.
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12 Configuration and Preferences

Most of the  Configuration  and  Preference  settings  are  available  in  the  Setup  Wizard  but  you  may
notice that some of these facilities are also directly available under the Tools menu. 

The Setup Wizard can be used to configure the following :

Laboratory name and address details
Nominal Categories (Advanced Only)
Users & Technicians
Price band details
Surgeon Types
On Bookout Options
Starting Surgeon Account number and Document/Invoice number
Data Backup drive letter
Quick entry of Dental Practices and Surgeon details
Product and Services (including prices)
Printing Setup
Customisation of new documents (New Document Setup)
New Job Setup and User Preferences

The following configuration items are available directly under the Tools menu as well as in the 'End Page'
section of the wizard.

New Document Setup

and

User Preferences

12.1 Operating an In House Surgery or Denturist department

Due to the rise in popularity of In-House Surgeries or Denturist departments, a future version of
Transactor will naturally support this business model. In the meantime,  there's several ways to setup
the current version of Transactor to support this functionality, see the summary below.

Disclaimer: 
We hope these solutions will work well for what you intend to use them for however they are ideas only
and not fully tested. Please configure and test your own system at your own risk and satisfy yourself
that the system works for you. Pearce & Robinson Ltd cannot be held responsible for any loss of data or
business resulting from using Transactor.

Separate Transactor installation method
This topic describes one method of using Transactor to administer an In-House Surgery or Denturist
using a separate Transactor installation. 
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Advantages
The installation can can be on any compatible pc anywhere in your business
An economical solution if you already have a licence for one transactor installation
Collect full customer/patient details, including post code address, telephone, email and history with
invoices and payments for each customer/patient.
Appointments can be made using the Book-in Action. The Due-Date can agree with your written desk-
top diary and the 'Booked In Jobs by Due Date' report acts as an appointment list
More Transactor instances can be installed, one for each Denturist or In-House Surgeon, if you wish to
account for each separately.

Disadvantages
You need to get used to the Surgeon Account labels and menus representing the Customer/Patient
instead. For instance Customer/Patient history is obtained from the Surgeon/History menu.
There is a charge for each Transactor instance (licence) however each one is usually about 50% of the
usual price of Transactor if the businesses are in the same parent company or share at least one
director. Contact Us  for a quote.

See: Separate Transactor Installation method

Combined Method
Use the same Transactor installation to administer the In-House Surgery or Denturist and the lab work
done for dental surgeons. Using this method means you don't have to install a second copy of
Transactor, and your monthly sales reports will include all sales including Direct. 

One special Surgeon account is used for each In-House Surgeon or Denturist for all the Direct sales (eg
In-House Surgeon Mr John Smith BDS), and the patient's full details are to be collected in the line item
area. To cut down on typing the extra 'Notes' rows (eg. Patient Addr, Patient Tel) can be added as
template item to all new jobs booked (Tools menu - New Document Setup).

Disadvantages
It's not so easy to search and identify the right job (Booked in with an appointment, or Booked out and
Invoiced) for the right Direct Patient
Direct sales jobs are mixed up with normal lab jobs so it won't be good for making appointments
The Booked In Jobs by due date report will be complicated and not so useful as a Job schedule for
Direct sales or normal Lab work
There will be unused line item rows (eg. Patient Addr, Patient Tel) visible on the form for normal lab jobs.

12.1.1 Separate Transactor Installation method

This topic describes one method of using Transactor to administer an In-House Surgery or Denturist
using a separate Transactor installation. 

The installation can be on the same pc as the normal Lab-to-Surgeon Transactor (with a different Icon
and data folder), or it can be installed on a new computer anywhere in your business.  Being a work-
around solution we must get used to the Surgeon Account being the Customer/Patient. 

An advantage of this method is that the Transactor desktop Icon, the log in passwords, the main colour
theme can be different to the other Transactor installations. You can of course specify a different
company name and product list etc.
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This method means that appointments can be made (New job booked in), appointments fulfilled,
treatment done and invoiced for (Job Modified and Booked out).

Ok, so let's get started. To book in work for this type of direct sales your system should first be
configured. See Configuring a separate Transactor for Operating as an In-House Surgery or Denturist
Department

Booking an appointment for a Direct Patient

With a clear Main Form type the patient surname into the Surgeon Account/Customer box and press
Enter. (This is a work-around solution so think of the Surgeon Account in terms of being the
Customer/Patient from now on).

If this Direct patient has been treated here before, they may be listed under Surgeon Name, choose
Select, or Add New.

If you chose Add New, enter the full name, address and other details of this new Customer/Patient.
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Confirm the address and telephone details with the Patient/Customer

In the Due Date (AKA Appointment date), enter the date which has been agreed with the customer
and written in your appointment diary

Choose Action New Job (F3) if you havn't already done so earlier
Enter one or more line notes to indicate the nature of the work required
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Choose Book In (F7). You could also put the Job On Hold if you want to check and confirm the
appointment first.

You may have chosen to print a Job Ticket (Direct Patient) at this point.
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Invoicing a Direct Patient after treatment

With a clear Main Form type the patient surname into the Surgeon Account/Customer box and press
Enter. (This is a work-around solution so think of the Surgeon Account in terms of being the
Customer/Patient from now on).
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If this Direct patient was given an appointment, or been treated here before, they should be listed under
Surgeon Name, choose Select, or Add New.

Choose Surgeon/History, or double click the Customer/Patient address, to bring up the History list. 
Right click the row with description 'Job Booked In' and choose Select onto Form. If it's not there, see 
Booking an Appointment

Choose Action Modify (F4) 
Enter the financial line items such that the total amount is correct 
Choose Surgeon - Add Payment (CTRL-P) if the customer/patient is paying now

113
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Notice that the Doc Balance (shown at the bottom left) will not be 0.00 if the payment is not
correct.

Choose Action Book Out (F8)

Configuring Transactor for Operating as an In-House Surgery or
Denturist Department

Install Transactor onto a separate pc from a trial CD, full installation CD or from the website download.
Use the Setup wizard to setup the company name, product list etc but do not enter any Surgeons or
Practices.

If you wish to import a similar product list and prices from another Transactor installation, you can 
restore from a backup , then selectively purge unwanted data as follows:

From the Tools Menu choose Utilities - Clear Database
In the Clear Database dialog, tick to delete the Transactions, Surgeons and Practice records only,
then choose Clear Database

107
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Add a Surgeon Type of Direct Patient

In the Setup Wizard add a new Surgeon Type 'Direct Patient'
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12.2 Using the Setup Wizard

Use the Transactor Setup Wizard to set many common Configuration and Preference  items. 

The  wizard  starts  automatically  (until  you  set  up  your  laboratory  name)  after  you  start  the  Live
Transactor, thereafter you can start it at anytime from the Tools menu or toolbar.. 

When you first Set up Transactor for your lab  you would typically follow the on screen instructions on
each page, pressing Next until you get to the last page.

After clicking Finish/exiting the Wizard you will have a blank Transactor window so either click FORM A,
or exit and log back in to Transactor.

To run the Setup Wizard 

On the Transactor tool bar, click the Setup Wizard icon.

or

 From the Transactor Menu choose Tools-Setup Wizard
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If you have already been through the initial Setup Wizard and know which specific item you want, you
can use the Skip To control to go straight to one of the pages 

To show more advanced setup items in the Setup Wizard

In the Setup Wizard's start page, choose the Advanced button.
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The Advanced button gives access to a set of tick boxes which turn on or off, visibility of some of the
pages. In the basic system for example, the Nominal Categories, User\Technicians and Surgeon Types
are hidden until you Enable these.

See also
Getting Started
Enable username and password log in
More Advanced Procedures

12.2.1 Laboratory Name & Address

On this  screen,  enter the basic  details  about  your  lab.  It's  worth  doing  this  carefully,  as  some  of  the
detail you enter on this screen will appear on documents such as Invoices and statements.
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12.2.2 Categories

Categories group sales and payment transactions for accounting and reporting purposes.

You may need to enable this advanced setup page  if it is not visible in the setup Wizard.

To Rename a Nominal Category

In the Setup Wizard, Categories page, highlight the Category you wish to rename (GOLD)
Click Modify

Edit the Category name. (eg. GOLD to PRECIOUS METAL). 
Caution: If you already have transactions which were assigned to this category, those transactions will
now reflect this new Category name.

If you wish to change the Nominal Number to reflect your external Financial Accounts System then do
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so here, it has no effect on Transactor other than showing alongside the Category name in the
monthly accounting reports.

Click Close, then click Finish to exit the Wizard.

After exiting the Wizard you will have a blank Transactor window so either click FormA, or exit and log
back in to Transactor.

See Also
Nominal Categories
Accounts Reports
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12.2.3 Users/Technicians

On this screen, you can enter or modify all the users and technicians who will be using Transactor.

You can add new users, modify details of existing users or delete users.

When you add a new user you need only enter the basic information and click OK. eg. Username, Full
Name and User Code, leaving the other items as they were.

Advanced
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Advanced  User  Preferences  will  allow you  to  grant  or  deny  access  for  certain  actions  and  reporting
facilities to different users. This is covered in the User Preferences  section.

See Also
Enable username and password log in
Change a User Password
User Preferences
 

12.2.4 Price Bands

Here, you can set up different Price Bands, which would typically be groups of prices.  In the Transactor
example company, we have set  up 3 Price Bands,  but  you can change these,  and Add New,  Modify or
Delete as you wish.

The  advantage  of  having  these  groups  of  prices  is  that  at  some  time,  you  may  want  to  make,  for
example,  an 'across the board'  price  increase,  and  rather  than  go  through  all  your  products  changing
prices individually, you can Change band prices by a percentage (see above).

And if you want to set up a new Price Band,  rather than create new prices individually,  you can use an
existing Price Band on which to base prices by clicking Copy prices from one band to another.  You can
then, if you want, fine-tune individual prices.

How to add a new price band and base it on an existing price band

In this example we'll create a price band for Direct customers suitable for sales from a Denturist or In-
House Surgery.
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In the Setup Wizard , click Next until you arrive at the Price Bands page.
Click 'Add New' to add a price band named 'Direct' 
To base the new Price Band on an existing one by choose Copy Prices From One Band to Another. 

Then choose 'Change band prices by a percentage' to achieve your Direct prices.

You may now use the Products and Services  page to tailor individual prices to suit variations that are
not an exact percentage of the original price band.

12.2.5 Surgeon Types

Surgeons can be grouped by Surgeon Types but for simplicity, all Surgeons are initially assigned to just
one group (Surgeon Type: Surgeon). 

120
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For most small Labs, sticking to the default (initially installed) Surgeon Type settings is ok so skip this
topic.

Initially, the Wizard will not show this setup page unless you ticked the box in the Advanced button on
the Setup Wizard's home page.

To change the settings for the default Surgeon Type
Start the Setup Wizard  

Choose Advanced and ensure Surgeon Types is ticked
Choose Surgeon Types from the Skip To drop-down list
Highlight the 'Surgeon' Surgeon Type and click Modify
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You can modify the following

Type Name
Initially this is set simply to 'Surgeon' (recommended), however you could change this to
something else eg. 'Normal Surgeon'
Default Price Band
When you create a New Surgeon account, this is the price band that will be initially selected.You
can over-ride this setting in the surgeons account record
Payment Terms
Any Surgeon accounts that are of this Surgeon Type will have this printed on their monthly
statements under 'Terms'
Default Credit Limit
Any new Surgeon accounts with this Surgeon Type will have their on-screen balance flashing in red
if they have reached this credit limit. You can over-ride this setting in the surgeons account record
Default Discount %
Any new Surgeon accounts with this Surgeon Type will start with this discount % on new jobs.
You can over-ride this setting in the surgeons account record.
Settlement Discount % and Days
An internal note of Settlement Discount which has been agreed. Not used by Transactor for
calculations. Not to be confused with the line Discount % which appears in the Customer record
and in the Dsc column on Jobs/Discount.
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Why use more than one Surgeon Type
The Payment terms text which gets printed on the monthly statements  comes from the Payment  Terms
box in the properties for the Surgeon Type. For example if you have 9 surgeons on "14 days"  and 23 on
"30 days" then you need to add a Surgeon Type to go with the default 'Surgeon' type.

Sample Surgeon Types

Surgeons30   Payment terms printed on Statements: "30 days"
Surgeons14   Payment terms printed on Statements: "Strictly 14 days"

Don't forget to set the Type box in the Surgeon record to the relevant Surgeon Type.

There are other things  such  as  Usual  Prices  which  will  be  set  for  you  when  you  add  a  new surgeon
account and select a Surgeon Type, but these can be over-ridden.

12.2.6 On Bookout Options

Here, you are given the option of specifying how you book out a job.
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Typically, you will charge (invoice) for the work  when you book it  out,  but  for some types of work,  you
may have other ways you wish to charge. For example, some jobs may be part  of a much larger piece
of work,  and you may have come to an agreement  with a Surgeon that  you won't  invoice him until  all
the work has been completed. This is where an option such as 'Ongoing' might be useful.

Explaining the 'On Bookout' box

This little beast does a lot to reduce invoicing errors and unnecessary typing but it does like to be
treated right. The right treatment means correct initial setup of the On Bookout Options  and the User
Preferences   by the lab manager.

The On Bookout box is displayed on the Main Form and shows what should happen as regards finalising
the job when the Book out (F8) action is done. 

On Bookout - 'On-Going'
When the Job is booked out, it will be temporary without charging. If you retrieve the job details

 during this period, the Job Status will display 'Booked Out On-Going'
On Bookout - 'Charge'

When the job is booked out. An Invoice will be generated on the system but may or may not
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be printed at this point depending on your configuration . 

Transactor can be configured to compliment most dental lab's ways of booking out and charging. 

Labs that usually Invoice for each stage 

If your lab is one which invoices for every stage (every time a job leaves the lab) then 'On Bookout'
should usually remain set to 'Charge' so that each job is automatically finalised when Booked Out
(F8). (Unless on the Main Form you change 'On Bookout' to On-Going before booking out .  

From the Tools menu, choose User Preferences
In the Initial Selections group, set 'On Bookout' to 'Charge'

Labs that usually don't Invoice for each stage

If your lab is one which doesn't usually invoice for every stage, for example a multi-stage
prosthetics project then 'On Bookout' should usually remain set to 'On-going' so that when Booked
Out (F8) the job won't be finalised. (unless on the Main Form you change 'On Bookout' to Charge
before booking out .  

From the Tools menu, choose User Preferences
In the Initial Selections group, set 'On Bookout' to 'On-going'

This setting affects the User Preferences for the user now logged on. If you have more than one User/
Technician involved with booking in and out jobs in Transactor, use the Setup Wizards - User/
Technicans  page to make the appropriate Initial Settings.

12.2.7 Starting Numbers

This page gives several ways to control surgeon account and Document/Job numbering.
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When you start creating Surgeon Accounts and Document-Jobs, the numbering will, by default, start  at
1. See below if you want to specify your own Starting Numbers on this screen. 

Surgeon Account Numbering

These numbers are assigned automatically as you add surgeon accounts to transactor. You can if you
wish, enter a starting number which must not be equal to or higher than any currently in use.

A Surgeon's account number is shown on the Main Form after the surgeon name in brackets. eg. Mr J
Beresford BDS (146)

Possible reasons to change the Next new Surgeon Account Number:
You may want Transactor Surgeon account numbers to be the same as your existing numbers. You can
only do this if you have not entered any surgeon accounts yet. Contact Transactor support if you want to
start again by purging your accounts. The method involves setting the 'Next new Surgeon Account
number" to the first one in your list of existing surgeons sorted by account number. Then add your
surgeon accounts carefully in the same order as your list. If you have any missing numbers create
dummy surgeon accounts to use up the number, then mark them deleted in transactor.

If you have two Laboratories or Departments working under the same company but with separate
Transactor installations, it may be advantageous to align your surgeon account records if both Labs/
Departments do work for these Practices. If this is the case, contact Transactor support who will be able
to help by duplicating your Surgeon records from one Transactor installation, into another.
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Document/Job Numbering

These numbers are normally assigned automatically as you book jobs into Transactor. You can if you
wish, type in your own job numbers on booking in. Alternatively you can keep with automatic numbering
(recommended) but assign a starting off number.

A Job/Document's number is shown on the Main Form at the top right.

Possible reasons to turn off automatic numbering of Job/Document numbers

You may have pre-printed Lab Prescription pads which you give to your surgeons, and you want the
Transactor Job/Doc number to be the same. However also consider leaving Job/Doc numbers automatic
and using the Reference box for your Prescription reference instead.

12.2.8 Data Backups

When you exit Transactor, you are given the opportunity  to do a data backup.  The destination drive
for the backup operation is pre-set using the Setup Wizard's  Data Backups page.

To Change the Default Data Backup Drive
1. Start the Setup Wizard and choose Skip to 'Data Backups'

2. Choose the drive letter where your backups should be located

3. Choose Finish
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Notes

The disk drive choice defaults to the 'C' drive, (usually, your computer's  hard disc  drive).  If you have a
USB memory stick,  for example,  your computer will  give this  its  own  'drive'  letter  which  you  should
see in Windows Explorer when the USB device is in place.

For example if your backup location is set to E (a removable storage device) you will  see the backup
files appearing in that drive's folder in Windows Explorer.

12.2.9 Surgeons and Practices

You will need a list of Dental Practice names, addresses and surgeon names for this task.



Configuration and Preferences 136

© 2010 Pearce & Robinson LTD, all rights reserved

Click  Next  to begin data entry  of Dental Practice name and addresses.  (Note  that  the  screen  below
will be blank when you first start to enter practice details).

Click Add New... to start adding new practices 
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Click Ok and then Add New again to complete entry of each practice. If you make any
mistakes, you can always choose Modify or Delete.

When you are ready to move on to entering surgeon details, click Next on the 'Dental Practices' window.

Now with your Practices in the system, start adding the surgeon accounts. When you first  start  entering
surgeon details, this screen will be empty.
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Click Add New... to start adding new surgeon accounts :
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And then OK and then Add New to complete entry of each surgeon account. If you make
any mistakes, you can choose Modify or Delete.

12.2.10 Dental Practices

Here is  where you will  add details  of Dental Practices.  Note that  the  screen  below will  be  blank  when
you first start to enter practice details.

Click Add New... to start adding new practices :
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And then OK and then Add New to complete entry of each practice. If you make any
mistakes, you can choose Modify or Delete.

12.2.11 Surgeon Accounts

Here  is  where  you  will  add  details  of  surgeon  accounts.  When  you  first  start  entering  surgeons  and
practices the list will be empty. If you have not yet added your Practices see Dental Practices 139
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Click Add New... to start adding new surgeon accounts :

And then OK to complete entry of each Surgeon Account. If you make any mistakes, you
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can always Modify... or Delete...

12.2.12 Products and Services

Here is  where you enter details  of the products  and services you deliver.  Note that  this  screen  can  be
sorted either by Code or Description.

Click Add New... to enter new products and services :

And then OK to complete entry of each Product/Service. If you make any mistakes, you can always
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Modify... or Delete...

Choose Properties to drill down into a Product/Service.

Choose 'More' for Technician and Stock Control settings. 
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Technician
Tick if you want to assign a Technician to each line item (product/service) put on jobs. If you have a very
small lab and most units go to just one Technician, choose a Preferred technician to save typing. This
can be changed when you add line items to a job.

Work Required
Tick if you intend to do advanced reporting and analysis on work outputs, using a 3rd party reporting tool
on the database. Assign an average work time per unit (in minutes).  

Stock Control
Tick if this Product/Service is a physical item (eg. Articulator) and you intend to keep track of the
quantity in stock.

Components
Add components if you want one product code to add several more line items to a job.

See Also
Stock Control Items

12.2.13 Printing Setup

If you are setting up Transactor for the first time you may click Next to skip this page for the time being.

68
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Initially you will be able view or print documents such as Despatch Notes from the simple Preview
Window.

If you are familiar with the requirements of Setting up printers etc and wish to optimize the printing
process now, read on.

Advanced - Allowed Printout Types for Document States

Setup or modify the allowed Printout Types for each Document State. You should not need to change
these settings.

Output Channels

Setup  or  modify  Output/Print  channels  to  printers,  files  and  batch  queues.  See  Printer  Output
Channels

Printout Type Properties

Setup or modify  Printout  Type properties  of  Invoices,  Delivery  Notes,  Credit  Notes,  Job  tickets  and
Reports such as Statements and Price Lists etc..  These properties include paper size,  font  size and
switches for printing to pre-printed or blank paper. See Printout Type Properties

Printing on Confirm Action
You can pre-set  the way Transactor handles  the usual printing of job tickets,  delivery  notes,  credit
notes, invoices and queries when you perform an Action (ie. Book In, Book Out, etc).

The Print  on Confirm Action  window allows  the  lab  manager  to  pre-set  the  usual  printing  settings
which appear in the Confirm Action window according to the Action being performed.

See Printing On Confirm Action

150
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12.2.14 End Page

See :

New Document Setup

and

User Preferences

13 More Advanced Procedures

The chapters in this section describe functions and procedures that are more advanced. Once you get
used to working with Transactor you may use them just as frequently as the functions described in the 
Basic Working Procedures  section. However, is probably a good idea to wait until you have a good
working knowledge of the program before you start studying these chapters.

13.1 Users, Technicians and Passwords

In the standard single user transactor installation, by default you will not need to log into Transactor. 

This is an option that can be turned on by Enabling Username and Password log in

In Transactor the user list can consist of:

 Anyone in your lab who may log into Transactor

151
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and/or

Technicians who you may wish to assign job items to when booking work in
 

Also See
Assign technician and work units to items

13.1.1 Add or delete a user

Start the Setup Wizard  and skip to the Users/Technicians page

In the list, highlight the User and choose 'Delete'

64
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Choose 'Yes' to confirm.

See Also
Enable username and password

13.1.2 Change a User Password

Start the Setup Wizard  and skip to the Users/Technicians page

In the list, highlight the User and choose 'Modify'

Enter the new Password into the 'Password' and 'Confirm Password' boxes and choose Ok.

See Also
Enable username and password log in

13.1.3 Enable username and password log in

In the standard single user transactor installation you will not need to log into Transactor. This is an
option that can be turned on using the Setup Wizard.

Enabling username and password log in

Start the Setup Wizard  tool
In the Setup Wizards start page, click the Advanced button, tick Users/Technicians and click OK

148
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Click Next until you get to the Users/technicians page
Tick Enable Logon for Users

NOTE
MANAGER is the only user account set up initially after installing Transactor. MANAGER has a blank
password by default so initially you can log in quickly without entering a password.
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See Also
Add or delete a user
Change a User Password
User Preferences

13.2 Printout Type Properties

To Configure Printout Type Properties

In the Main Form, from the Tools Menu choose Printing Setup - PrintOut Type Properties

Setup or modify  Printout  Type properties  of  Invoices,  Delivery  Notes,  Credit  Notes,  Job  tickets  and
Reports such as Statements and Price Lists etc..  

These properties include paper size, font size and switches for printing to pre-printed or blank paper. 

Also See
Creating A Letterhead

13.3 Printer Output Channels
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To Configure Output Channels
In the Main Form, from the Tools Menu choose Printing Setup - Output Channels

Output Name
This is your chosen assigned name, it could be 'Lazer Printer' for example
Output Type

Batch Queue :  Sends the document or report to the batch queue for printing later via the Print
Manager
Printer : Sends direct to the Assigned Printer (see the Button 'Assign to Printer')
File Path : A special file will be created in the specified Folder. Requires a Report Viewer available
from Technical Support however if you wish to create PDF files suitable for emailing see How to
Email Documents, Invoices or Reports

13.4 New Document Setup

You can configure Transactor to automatically have a certain layout on the screen when a new job is
started. Any of your existing predefined Line Notes can be made to appear in the new job.

Choose New Document Setup… from the Tools  menu.

106
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From here you can customise the level of pre-set details you want to record with each :

New Job
New Credit Note
New Query

You can specify  up to  6  line  notes  that  will  be  automatically  added  to  a  new blank  document  (ie.
when you choose Action... New Job, New Credit Note or New Query).

Select  the line notes  from the dropdown lists.  To remove a selection,  choose the blank entry  at  the
top of the list.

13.5 User Preferences

These User Preferences can speed up and simplify your work with Transactor.

To Change User Preferences

Start the Setup Wizard  and go to the Users/Technicians page120
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In the list, highlight the relevant User and choose 'Modify'

 

window Field Description

Prompt after Action... Clear Form Cursor prompt position on the Main Form after
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Action... Clear form

Prompt after Action... Modify Cursor prompt position on the Main Form after
Action... Modify

<Tab> to Cursor prompt positions included (ticked) and
excluded (un-ticked) when the user presses the
TAB key.

Options... Maximize document form
windows

When Main Form windows are opened they
automatically maximise within the Transactor
main window.

Options... Clear Document Form after
Action

The Main Form is cleared automatically after
Action... Book In, Book Out, Hold,…

Options...Confirm Action... Modify After choosing Action... Modify, a window asking
for confirmation pops up.

Initial Selections... Surgeon Type Your preferred surgeon type.

Initial Selections... Due Date The default Due Date after Action... Clear form.
This can be blank or a specific date or TODAY +
or - a number of days.

Initial Selections...On Bookout The default On Bookout option after Action...
Clear form

Initial Selections... Payment Method Pre-selected method when Payment window is
invoked to add a new payment.

Advanced User Preferences
Clicking the Advanced button will allow you to set further user preferences.

These preferences can be useful where the lab has, for example, a hierarchy of users, with  the most senior
user(s) being able to  access  the  Maximum  number  of  reports  available  and  actions  allowed,  with  more
junior  users  accessing  the  Minimum  number  of  reports  available  and  actions  allowed.  'L1'  and  'L2'  are
intermediate levels between Maximum and Minimum.
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You can also set your system up to grant or deny users the ability to :

add new products and services

give refunds

suspend / delete a Surgeon Account

display Surgeon Account Balance

13.6 Changing the Form Text Font

Choose Font… from the Tools  menu.

You can change the font of the text on the Main Form to a different size and style. 

This won't change the fonts used in list windows.

13.7 Maintenance Menu

Transactor  provides  a  Maintenance  Menu  -  available  from  Transactor's program  group  when  you
install  Transactor.  (From  Windows,  Start...  All  Programs...  Transactor  v6.1...  Maintenance  Menu).
See below.
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Warning

Improper use of the Maintenance Menu facilities  could damage your Transactor data.  If you are not
an IT professional Contact Us  before using these functions.

Backup Database

This provides you with an advanced way of backing up your data.  It  is  done when Transactor is  not
running. 

1. Close Transactor if it is running

2. In Windows, select Start... All Programs... Transactor v6.1... Maintenance Menu 

3. Choose 'Backup Database'

4. You will be prompted to enter a location and filename. You could include today's date as part of the
filename, to help you uniquely  identify  the backup.  Filenames (before the '.zip') must  be  no  more
than 8 characters long and must contain (a combination of) only letters and numbers.

5. Click OK.

Restore from Backup

This  provides you with an advanced way  of  restoring  your  data.  It  is  done  when  Transactor  is  not
running. 

1. Close Transactor if it is running

185
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2. In Windows, select Start... All Programs... Transactor v6.1... Maintenance Menu 

3. Choose 'Restore From Backup'

4. You will be prompted to enter a location and filename (see above).

5. Click OK.

Repair Database

This  option repairs  the  unlikely  situation  where  data  files  may  have  accidentally  become  corrupted
due  to  computer  crashes,  power  loss,  etc.  After  this  Repair  Database  operation,  you  must  then
choose 'Re-Index Database' (see below).

Re-Index Database

This option rebuilds all the database indexes (keys) from scratch,  and doesn't  affect  any data.  It  can
be used if you get any 'key out of date' messages on your system.

You should always re-index the database after doing a Repair (see above).

Set Database Location

When you first install Transactor,  the default  database location - where your data is  held - is  set  to
c:\tran61\lab\live\data. There would usually be no need to change the database location, but you may,
for example, want Transactor on a different  drive or in a different  folder,  so this  option allows you to
change the location.

Convert old db to v6.1

If you have a previous version of Transactor, and you want to convert it to version 6.1 :

Make a note of your old Transactor print settings

Choose the location of your old Transactor (usually c:\Tran61\lab\exe\Tran.exe for Transactor v
5.2 users) and click OK

  All your data will now be transferred to your new Transactor v 6.1. Note that :

   Delete any old desktop icons you have for previous versions of Transactor

   Re-apply any old Transactor printer settings to your new Transactor using the Setup Wizard

13.8 Verify your data backup

It is unlikely that you will ever need to restore your data from a backup, but it does sometimes happen.
You can never be sure that your pc will not suffer a power interruption or hardware failure just at the
wrong time. Usually the data can be repaired or re-indexed in place by using the Maintenance Menu
however if the data is badly damaged you may need to restore from a backup.

The most secure backups are to an external device such as a USB memory stick. 
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With a small about of care and effort you can periodically check the integrity of your backups.

There's the Daily Check that takes just a few seconds during each daily backup when you exit
Transactor,  a check that is recommended monthly or whenever you change your backup drive or
device, 
and there's a Full Backup Verification.

Verify your data backup - Daily Check

When you exit Transactor, perform your usual data backup

In the black command window, observe the progress of the files being 'Added' and check the
following:

1. Each 'Adding File' row should end in 'done.'.
2. The last 'Adding File' row should be for the USER file because it is in alphabetical order.
3. The window should finish by displaying 'Data Backup Finished', 'Press any key to continue'.

If you observe any error messages, check that your backup device is correctly inserted, and that
the Default Backup Drive  is correctly set.  

Verify your data backup - Monthly check

When you exit Transactor, do your usual backup but take a note of the Backup Drive letter

134
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In our example it's drive G, we are using a USB memory stick.

After the backup is done, open Windows Explorer  (Use the combination Windows Key + E or My
Computer Icon)
In Windows Explorer, navigate to the Drive noted earlier, and locate the most recent compressed
backup file

The last Backup File created should be visible. The naming convention is MMDDHHNN  (Month,Day,
Hour,Minute). 
 

If you do not see your file, check that your backup device is correctly inserted, and that the 
Default Backup Drive  is correctly set.  

NOTE: 
If in your Windows Explorer you can only see the file names (not the extension or Date Modified),
change your folder display options, or right click the file and choose Properties.

Full backup verification by restoring to a duplicate installation

When you exit Transactor, perform your usual data backup
Use the method described in the monthly check, to identify the exact backup file
Install Transactor on another PC  'The Backup PC'
Restore the backup data to the Backup PC using the Maintenance Menu
On the Backup PC run Transactor, and go to the last few jobs to verify the data is intact and
working correctly.
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NOTE: 
If you are a Premium Support customer, you may periodically email your recent backup file to 
Transactor Support . We will confirm the data has been verified and stored securely on our server.

SEE ALSO
Do a normal Daily Backup
Protect your PC from power failures

13.9 Protect your PC from power failures

You can never be 100% sure that your pc will not suffer a power interruption or hardware failure just at
the wrong time. 

Usually the data can be repaired or re-indexed in place by using the Maintenance Menu  however if
the data is badly damaged you may need to restore from a backup.

For the above reasons, and for extending the life of your computers, we recommend the added protection
of an Uninterruptible Power Supply (UPS) such as the product below available from most Computer
suppliers.

http://www.apc.com/index.cfm
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The cost  of a backup is  peanuts  in comparison to the risk  that  your  business  will  be  interrupted  by  a
damaged computer system/and or data leaving you wishing you didn't have to rely  on your previous data
backup. 

14 Accounting

Transactor has a built-in Sales Ledger with support for controlling your debtors, including the following
features :

All Transactions correctly accounted for using Nominal Categories with an optional Nominal Number
for co-relating with a Financial Accounts System.
Meaningful accounting reports such as the Analysis by Category report . The information from this
summary report is commonly used by the company's book keeper to update the company's manual
ledgers or Financial Accounts System.
Aged Debtor Reports
Instant Surgeon account history with running balance
Credit Limit tracking
Payment transaction handling including Adjustments, Settlement Discounts, Refunds and Write-Offs. 
Payments and Credits are allocated to one or more transactions, manually or with Auto-Apply.
Payments and Credits can be un-allocated or re-allocated at any time, using the right click menu in
the Customer History
Easy statements. With a choice of the following types.

Simple Summary Invoice (no aged analysis, no balances, no payments)
Statement Monthly (Balance B/F, all transactions, Balance C/F aged analysis 1,2,3 month) 
Statement by Date Range (as above, but with aged analysis 30,60,90 days)
Sage style Statement (unpaid invoices only)

Chapter Contents

Accounts Reports
Nominal Categories
Working with a Financial Accounts System

See Also
Surgeon Accounts
Allocating a Payment to Unpaid Invoices
Unallocated Credits
Walk thru Payment allocation and Credit Note
Do the end of month Statement and Locking
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14.1 Accounts Reports

Analysis by Category

You would normally print this off at the end of each month and hand it to your book-keeper. The
information from this summary report is commonly used by the company's book keeper to update the
company's manual ledgers or Financial accounts program.

1. From the Reports menu, choose General - Analysis by Category
2. Enter the date period and output as required

Columns

TranType 
Standard accounting Transaction type codes as follows

SI Sales Invoice, SC Sales Credit
JD Journal Debit, JC Journal Credit

Nom Category
Transactor  Nominal  Category  Names  used  to  group  your  transactions  and  to  control  the  built-in
Sales Ledger

Nominal
These Nominal Numbers  are those that  are set  in the Setup Wizard Categories  page,  and  can  be
whatever you like.  You can  set  these  Nominal  numbers  to  the  same  as  your  Financial  Accounts
System.
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Accounts Receivable

This Accounts Receivable report lists payments in a period, grouped by Payment Method. 

1. From the Reports menu, choose General - Payments
2. Enter the date period and output as required

Audit Trail

This report lists all transactions in chronological order

1. From the Reports menu, choose General - Audit Trail
2. Enter the date period and output as required
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14.2 Nominal Categories

Transactor  Nominal  Categories  are  used  to  group  your  transactions  and  to  control  the  built-in  Sales
Ledger. 

First we will look at what these are and how they are used in Transactor,  then we can see how to make
changes.

In Transactor all product items, and payment methods are assigned to particular Categories. eg.

Product Category
Full Upper and
Lower

PROSTHETICS

Gold Inlay CROWN & BRIDGE
Gold (gms) GOLD

Products are assigned to Categories when you add or modify a Product Item.

Payment Methods are permanently assigned by the system. eg.

Payment Method Category
Cheque BANK-CHEQUESCASH
Cash BANK-CHEQUESCASH
Write off under
payment

ADJUSTMENT-CREDIT

Write off over
payment

ADJUSTMENT-DEBIT

You can see the other available payment methods in the Payments dialog. For Debits you have to click
the Debit radio button.
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With all Transactions being correctly accounted for we can get meaningful accounting reports such as
the Analysis by Category report . The information from this summary report is commonly used by the
company's book keeper to update the company's manual ledgers or Financial accounts program.

To change or rename Nominal Categories that you can assign to Product Items, use the Categories
page in the Setup Wizard . You may need to enable this advanced setup page  if it is not visible in
the setup Wizard.
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14.3 Working with a Financial Accounts System

The problem

You want your invoices and payments from your sales order system (Transactor) to show in your
existing financial accounts system (FAS), so that it can present the correct figures (profit and loss
report) for you and your accountants.
You don't see how to export these transactions to your FAS.

The solution

All you need is to print out the Analysis by Category  and Payments report once a month
Enter a couple of monthly transactions into the FAS representing the Sales Invoice (SI) month total as
one invoice against  one customer account  named something like "Customers  consolidated".  Repeat
this step if there are any Credit Notes that month. 
Similarly  one Sales  Receipt  transaction  for  each  Payment  Method  eg.  Cheque,  BACs.  or  Payment
Adjustments. Allocate this payment credit to the sales transaction above.
In your FAS's  bank  reconciliation  routine  you  can  reconcile  any  cheque  deposits,  or  bank  receipts
received during the month, with the help of Transactor's payments report.

Note  that  the  above  is  the  simplest  implementation.  You  can  get  more  resolution  in  your  FAS's
management  reports  if  you  use  more  sales  categories  such  as  'Sales-CrownAndBridge',  'Sales-In-
House-Surgery'. 

The benefit of using a specialized Sales Order Processing front end (eg. Transactor) for your day to day
transactions is that your FAS system is not cluttered up with many thousands of invoice and payment
transactions which can, in most inexpensive Accounts Programs, cause the system to slow down.
Another benefit of following the simpler approach given in the solution above, is that you do not suffer the
problems of replicating payment allocations (and adjustments after the fact) in two separate systems.
Such things would otherwise cause data entry duplication at best, and at worst cause inaccuracies.

For more information on Transactor's built-in sales ledger functionality and controlling your debtors
please see the following topics in Transactor Help

Also See:

Accounting Reports

15 Definitions

15.1 Copyright

Copyright
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©2009 Pearce & Robinson Limited. All Rights Reserved.

Information  in  this  document  is  subject  to  change  without  notice.  The  software  described  in  this
document is furnished under a licence agreement  or nondisclosure agreement.  The software may be
used or copied only  in accordance with the  terms  of  those  agreements.  No  part  of  this  publication
may be reproduced, stored in a retrieval system, or transmitted in any form or any means electronic
or  mechanical,  including  photocopying  and  recording  for  any  purpose  other  than  the  purchaser’s
personal use without the written permission of Pearce & Robinson Ltd.

15.2 Dedicated Server

A dedicated server is  a single computer in a network  reserved for serving  the  needs  of  the  network.  A
dedicated server could also be a computer that  manages printer resources.  Note,  however,  that  not  all
servers  are dedicated.  In some networks,  it  is  possible for a  computer  to  act  as  a  server  and  perform
other functions as well.

Although some Labs use the server as  a workstation as  well,  it's  not  recommended because the whole
network may become unreliable due to various applications running directly on the server which affect  all
the other workstations on the network.

If for example,  you wanted two workstations for  use  with  Transactor  or  other  applications,  you  would
need 3 computers, 1 of which would ideally be more powerful and used as the dedicated server. 

Data files for Transactor, and your other shared applications such as  document files,  would be located
in shared folders on the dedicated server.

Servers  in  particular,  should  be  protected  from  power  interruptions.  See  Protect  your  PC  from  power
failures

Contact Us  for more information about installing Transactor on a network  

16 Frequently Asked Questions

This section covers some problems that are frequently encountered by users of Transactor. The
questions are organized by category and where necessary links are provided to relevant sections of the
help. 

Also see 
Did You Know.. ?

Please visit the website for the latest revised FAQs

Top20 Frequently Asked Questions

Dental Lab System Knowledgebase 

Whats new in this version ?
Lots. See Version History
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How do i run Transactor on the new Vista operating system ?
You need to assign administrator rights in all the Transactor Shortcut properties. See Do this if you have
Vista or Windows 7  

How do I find a Job when I don't have the Job Number ?
There are a number of ways you can do this, for example, by using the Document Number, instigating a
Patient Search, finding the Surgeon, or by navigating through recent documents. See Finding a Job

How do I Email Documents like Invoices, Quotes or Reports ?
Use a 'PDF Printer' AKA 'Virtual PDF printer' such as Cute PDF Writer (Follow the "3rd Party tools" link
on www.transactor.co.uk ). We recommend you ask your local computer person to install it for you.
More..

How do I interface with or send transactions to my Sage Accounting software ?
Whether you have Sage or any other external accounts program, there's no need to get involved with
interfacing. This is because Transactor has a built-in Sales Ledger for Transactions, Payments and
Statements. More..

I'm trying to choose a Function or Action but the item is greyed out. Why ? 
Those Functions or Actions aren’t appropriate for the current state of the Main Form. See Understanding
Actions

I want to alter a Job but it won't let me. why not?
If you can't choose Action... Modify then the job has been Locked 

I booked a job into the wrong Surgeon, how do I change it - the Select Surgeon menu is greyed out ?
Unless the job being newly booked-in, Transactor won’t allow you to change the Surgeon. You’ll need to
delete the job and start a new one. See Understanding Actions

I've got all the month's jobs on Transactor, how do i enter the sales receipts and print statements.
Try this. Walk thru Payment, Statement and Posting  and Walk thru Payment allocation and Credit
Note

What is the Lock Finalised Documents item under the tools menu, and when should I do this?
Locking and Posting Jobs  is normally done after the end of the month.

What happens if i never do a Lock Finalised Documents ?
Eventually the Surgeon History window will reach its limit for displaying un-locked 'blue' jobs
(approximately 300 for each surgeon) at which point you will be warned that the Locking of Finalised
Documents  is overdue.

How do I retrieve a job by job number rather than by using the surgeon history list ? 
On a blank Document Form, type the job/document number into the Doc. No. box and press Enter.

Transactor is running, I can see the menu bar but my main booking form isn’t visible.
Someone has closed the Inner window which displays the Main Form. Click ‘View – Form A’ on the
menu bar, or click the Form button top left on the tool bar. 

If you booked a job and charged for it, can you still bring it back and modify the details ? 
It depends on the circumstances. The answer is 'yes' if you’ve booked the job out and haven’t performed
an end-of-month Locking of Jobs in that date range yet. See  Locking of Finalised Documents  and
Modifying a Job
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A surgeon overpaid me. How do I give him a refund ?
When the Surgeon details are on the Main Form, make a payment transaction of type 'Debit/Refund' and
choose the Refund Method method More..

How do I back up to a different drive or device ?
Use the tool to change the 'backup to' drive. Backing Up & Restoring Your Data

How do I get Transactor to automatically print 2 (or more) documents, rather than 1 ?
Go to Tools... Printing Setup... Printing on Confirm Action. In the right-hand column, you can change the
number of copies you print for, e.g. Invoices, Credit Notes and Delivery Notes. See Printing On Confirm
Action

How do I change which printouts automatically come out when I action a job ?
Go to Tools... Printing Setup... Printing on Confirm Action. Transactor sets certain defaults for what is
printed when you book in, book out jobs, etc., but you can change this to suit your own requirements.
See Printing On Confirm Action

How do I give a Credit Note ?
You can issue a Credit Note for an existing job, issue a Credit Note from scratch, or allocate a Credit
Note to unpaid Invoices. See Credit Notes

I've got a job/document which I've charged for. It's for the wrong amount and it's in a Locked condition
so I can't modify it. What can I do ?

Follow standard accounting practice by issuing a credit note against it. Then do a new one. You can
save work by using the ‘Action... New Credit note' menu item when the erroneous job/document is on
the document form

I have some surgeons to whom I give ‘special' prices. How can I make sure that they are always
charged the agreed price ? 

There are two ways you can do this; one is by modifying the Surgeon's details, the other is by setting up
a new price band for a specific surgeon. See Special Prices

I would like to increase my prices by a certain percentage. How do I do this without modifying each
product line ? 

Click on Tools... Setup Wizard and then Skip To Price Bands. Click on the button ‘Change band prices
by percentage', select the appropriate band from the drop down box, enter the percentage and click on
‘Yes'. Click 'Finish' when done.

I would like to print my own letter heading onto blank paper, perhaps including my logo. How do I do
this ? 

See Creating A Letterhead

When I run the Aged Debtors Report I seem to have a lot of unallocated credits. Why is this ? 
There can be two main reasons for unallocated credits. See Unallocated Credits

An invoice is not showing up on the statement; what should I do ? 
The Job/Document has probably been Finalised (booked out charge) with the wrong Tax date or hasn't
been Bookout-Charged. More..

A Surgeon's sales payment has been entered but it's not showing on the month's Statement. Why ? 
The Tax Date of the Payment transaction is not in the Statement month or date range. You can modify
or delete and re-enter the payment transaction  if is not yet posted, or tell the surgeon it will show up
on next months statement. Use the Surgeon's account history window  to find out what's going on.
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If my computer crashes, will I lose all the jobs I have entered ? 
If your computer restarts normally, your data should be intact, otherwise your data may need repairing,
please  Contact Us

I need a report that isn't on the Reports menu. How can this be set up ?
Let us know what kind of report you would like, and we can add it to our Wish List. Alternatively, if it is
required urgently, we can do this for a charge; please  Contact Us  for details.

I want to run Transactor on another computer in my lab. Is this possible ?
Yes. You need your IT person or supplier to Network your computers then Contact Us  for help in
configuring Transactor. A multi-user licence upgrade will be payable. We strongly recommend you have
a Dedicated_Server  and Protect your PC from power failures

16.1 Version History

Version History: v6.17 22July2010

* Maximum no of line items per job increased to 64
* Fixed: Print Server Is Busy message now occurs less often and clears itself as stated once Transactor
is logged out and back in.
* Added: By popular request, another report option allows printing of one or more whole pages of address
labels for one specified Practice or Surgeon. The usual label printing options are unaffected. 
* Improvement: In Patient Statements, if a custom price has been used on a Job line item, GRADE is
taken from the Usual Price Band rather than being left blank 
* Other  minor adjustments: Various small improvements in labelling and  presentation.
* New Setting Option. AutoDate Yes/No, which if set to no will cause the "Invoice Date" edit field in the
Action - Confirm Bookout Charge dialog to be blank instead of the current date. See Note 3
The following two changes will be particularly useful for labs that charge/invoice for each job stage basing
new jobs on the previous job having that reference/case no. 
* Action 'Copy To New' now remembers the last used setting for deciding whether or not to ''Copy Line
Items' (ie Priced items).  See Note 1
* New Setting Option, AutoReference Yes/No, which if set to Yes causes the Reference box on the
document form to be automatically populated with the DocNo value after Action - New Job.
Note: if Reference is already populated, it will not be overwritten. See Note 1 and 2

NOTE 1
These two changes will be particularly useful for labs that charge/invoice for each job stage basing new
jobs on the previous job having that reference/case no. These changes should make it much easier to
handle a 'case' (ie. a set of jobs) where each job is charged separately and has a common Reference
'Case number' which would be the Job No of the first job 'New Job'.
If Auto Reference setting is Yes, this causes the Reference box on the document form to be
automatically populated with the DocNo value after Action - New Job.
NB: if Reference is already populated, it will not be overwritten.
To start a new case, when booking the job in for the first time use Action - New Job.
This populates the Reference with the Doc No.
When the first stage of the job is completed, it should be Action - Booked Out charged.
If the Job comes back into the lab, you can either enter the Doc No or lookup by Tools - Reference
Search.
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When the Job is displayed on the Transactor screen...
Action - Copy To New
This will, start a new job, by carrying over all non-financial job details to a new job, the Reference (Case
no) will stay the same.
You can then add job items and Bookout charge when the next stage is completed.
and so on....
NOTE 2
How to Set Auto Reference. (Computer skills required ).
Auto Reference Yes/No is a new setting stored in the TrnLab61.ini file. The following entry, inside the
[company alias] or [Live] section...
AutoRef=1
Manually setting this entry to 0 (eg. AutoRef=0), or removing the entry, switches off this feature.
NOTE 3
A new setting stored in the TrnLab61.ini file. The following entry, inside the [company alias] or [Live]
section...
AutoDate=0
This will cause the "Invoice Date" edit field in the Action - Confirm Bookout Charge dialog to be blank
instead of the current date.
Manually setting this entry to 1 (eg. AutoDate=1), or removing the entry, switches off this feature.

Version History: v6.16 15Mar2010

Medical Devices Directive 2007/47/EC becomes UK law on 21st March 2010. Transactor v6.16 includes
the new 'Patient Statement' which conforms with the MHRA guidance. The update is free of charge for
premium supported customers.This Transactor update means Dental Labs can easily comply with the
new directive with minimum fuss and administration overhead.Download the free user guide for more
information http://www.transactor.co.uk/data/UsingPatientStatements.pdf  How to get this update: If you
are a premium supported customer you should automatically receive a letter on how to download the
update.Customers who are not signed up for Premium Support can obtain the update by purchasing 12
months' premium support from Products page of this website. 
Terms:
* MHRA: Medicines and Healthcare products Regulatory Agency
* MD Directive: Medical Devices Directive. The Medical Devices Directive covers the regulatory
requirements of the European Union for Medical Devices.
Also See: http://www.mhra.gov.uk/Howweregulate/Devices/MedicalDevicesDirective/Dentallaboratories/
index.htm

Version History: v6.15 05Aug2009

* New  Customisable Label Printing reports
* New  Report Menu. Categorized for easier selection 
* New  report. New type of Statement which lists unpaid Invoices only  (similar to Sage). 
* Reports  Improved: Summary Invoice and Practice Summary Reports sorted in  name order. Easier to
collate different report runs. These reports  now support selection by Surgeon Profile. Profile groups are 
assigned in the Surgeon Record.
* Improved  Reporting: You get a message saying a report is empty instead of a  blank page. 
* Revised  and extended Help and printable User Guide
* Screen  speed buttons: Improved layout 
* Set  up Wizard - Surgeon Type Page. Clearer guidance for Settlement  Discount Setup 
* Additional  Payment Method - Late Settlement Charge 
* Quotes.  The On-Hold/Quote Action now makes it easier to produce Quotes for  Jobs or just put a job
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on Hold
* Usability  improvement: When Credit Notes are added, automatic prompt for  credit to be allocated to
unpaid invoices. Reduces occurrence of  unallocated credits. 
* Usability  improvement: Surgeon account's 'Live Balance' renamed 'Current  Balance' and no longer
includes non-finished jobs (i.e. 'Open'  documents). The current balance more meaningfully shows the
account  state at time of most recent 'invoiced' or finalised document. In  addition the value of 'open' jobs
(i.e. Unfinished jobs) are  totalled separately. (standardised book-keeping) 
* Usability  improvement: Toolbar button for Add Payment (also available under  the Surgeon Menu). Exit
toolbar button removed - minimizing clutter.  Use File-Exit or Window [X]. 
* Usability  improvement: The term 'Posting' has been changed to 'Locking'. This  describes more clearly
what is happening with the records. 
* Bug  fix: Payment allocations - allocation left hanging if a Finalised  invoice was un-finalised and
modified. 
* Bug  fix: Surgeon accounts which are not assigned to any Practice are now  visible in the Setup
Wizard's 'No Practice' list 
* Maintenance  Improvement: More helpful handling of Database error on startup  "KeyOutDate": This
error may have happened after a power  interruption or incorrect shutdown of a pc. A message box
guides the  user to the Maintenance Utility to Re-build Indexes to quickly get  up and running. 
* Transactor  Maintenance checks On startup: *.net & *.lck files are deleted -  this may help in some
cases where a "Multi-net file" error  might occur after a power interruption or incorrect shutdown of a  pc.
Clear Print Server utility will automatically clear printer  problems after a new printer is installed or a print
job fails. 
* New  Clear Printer Assignments button: In Tools-Printing Setup-Output  Channels.. new button "Clear
Printer assignments...". Use  as directed by Transactor Support team. 
* Networked  Multi-user systems only: Master/Backup PC checkbox in Setup  Wizard/Data backups
page simplified. The master pc/server will by  default be assigned as the "master/Backup PC" in the
Setup  Wizard. However, all other workstations should have this setting  un-ticked. 
* Other  minor adjustments: Various small improvements in labelling and  presentation. 

16.2 Find out what operating system you computer is using

There are many versions of the Microsoft Windows operating system. You may be using Windows 98,
Windows Me, Windows XP or another version. To make sure you know which version is on your
computer:

   1. Click Start, and then click Run.
   2. In the box, type winver, and then click OK. 

The window that appears will show you which version of Windows your computer is using. If your
operating system has a service pack installed, you will see the service pack listed
Note: These instructions do not apply to Apple Macintosh computers. 

16.3 How do I export to an Accounting Program

The problem

You want your invoices and payments from your sales order system (Transactor) to show in your
existing financial accounts system (FAS), so that it can present the correct figures (profit and loss
report) for you and your accountants.
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You don't see how to export these transactions to your FAS.

The solution

All you need is to print out the Analysis by Category  and Payments report once a month
Enter a couple of monthly transactions into the FAS representing the Sales Invoice (SI) month total as
one invoice against  one customer account  named something like "Customers  consolidated".  Repeat
this step if there are any Credit Notes that month. 
Similarly  one Sales  Receipt  transaction  for  each  Payment  Method  eg.  Cheque,  BACs.  or  Payment
Adjustments. Allocate this payment credit to the sales transaction above.
In your FAS's  bank  reconciliation  routine  you  can  reconcile  any  cheque  deposits,  or  bank  receipts
received during the month, with the help of Transactor's payments report.

Note  that  the  above  is  the  simplest  implementation.  You  can  get  more  resolution  in  your  FAS's
management  reports  if  you  use  more  sales  categories  such  as  'Sales-CrownAndBridge',  'Sales-In-
House-Surgery'. 

The benefit of using a specialized Sales Order Processing front end (eg. Transactor) for your day to day
transactions is that your FAS system is not cluttered up with many thousands of invoice and payment
transactions which can, in most inexpensive Accounts Programs, cause the system to slow down.
Another benefit of following the simpler approach given in the solution above, is that you do not suffer the
problems of replicating payment allocations (and adjustments after the fact) in two separate systems.
Such things would otherwise cause data entry duplication at best, and at worst cause inaccuracies.

For more information on Transactor's built-in sales ledger functionality and controlling your debtors
please see the following topics in Transactor Help

Also See:

Accounting Reports

16.4 How to Email Documents, Invoices or Reports

How to Email Documents, Invoices or Reports

Use a 'PDF Printer' AKA 'Virtual PDF printer' such as Cute PDF Writer (Follow the "3rd Party tools" link
on www.transactor.co.uk ). We recommend you ask your local computer person to install it for you

FAQ Content:
Once you have a virtual printer program installed on your PC you can choose to print to a PDF file
instead of to paper. These files are ideal for emailing as attachments. Print to your "PDF printer" instead
of your normal printer. The PDF file can be attached to emails.

When printing Transactor Invoice or Statements choose "Print Preview", then choose to print to the PDF
Printer instead of your normal printer. .
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NOTES:

When the Virtual printer is installing, choose NO to making it your default printer or it could cause you
inconvenience when printing your usual documents.

In Transactor you can configure the PDF Printer as a Printer Channel so that you can save time by
choosing this rather than Preview Window. In Transactor choose Tools - Printing setup - Output
Channels, add your PDF Printer as an Output Channel and click Assign Printer.

Ask your computer person to check your Printers in the Windows Control Panel and help you set up
your printing preferences in Transactor

16.5 Special Prices

There are two ways you can apply special prices :

by modifying the Surgeon details
by setting up a new price band for a specific surgeon.

Modifying the Surgeon details
  
If you give a set  discount,  e.g.  10%, bring the surgeon onto the main Transactor screen and from  the
menu bar click on Surgeon... View/Modify. Enter the discount amount in the ‘Discount %' field. Click OK.
Every job you create for that surgeon will now have a 10% discount applied

Setting Up A New Price Band For A Specific Surgeon

You can set up a new price band for a specific  surgeon.  Click  on Tools...  Setup Wizard and click  next
until you come to the Price Bands page.  Click  on Add New,  enter the ID letter and add a name for the
price band. click on OK. If most of the prices are the same as one of the other bands then you an copy
the prices over using the ‘Copy prices from one band to another' button. Click next until  you come to the
products  and services page.  Select  a product  in  the  list  and  click  Modify.  Set  the  price  for  each  new
price band then click OK. Repeat  for each product  in the list  and click  on finish when completed.  Bring
the surgeon onto the main Transactor screen and from the menu bar click  on Surgeon...  View/Modify.
Set  the 'Usual Prices' dropdown box to  the  correct  price  band.  Click  Finish.  The  surgeon  will  now be
charged by the selected price band on every job.

16.6 Unallocated Credits

There are two main reasons for unallocated credits :

1. Firstly,  you  may  have  issued  Credit  Notes  for  a  surgeon  that  haven't  been  allocated.  To  allocate
these to invoices click  on View...  Jobs/Documents  and  change  the  'Find'  dropdown  box  to  ‘Credit
Notes'. If any Credit  Notes  do not  have a tick  in the 'Paid' column then right  mouse click  each one
and select Allocate Credit. Then apply it to the appropriate invoice.

2. Secondly,  you  may  have  some  payments  which  were  not  allocated  when  they  were  entered  into
Transactor. You need to select  the relevant  surgeon onto the main Transactor screen and look at
their  history.  If  there  are  any  payments  which  do  not  have  a  tick  in  the  'Paid'  column  then  right
mouse click each one and select Allocate Credit and apply it to the appropriate invoice.
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16.7 Invoices Not Showing

If an Invoice is not appearing on a Surgeon's statement then it is likely to be for one of the following
reasons :

1. The Job/Document has been Finalised (booked out charge) with the wrong Tax date,  in other words,
the Invoice would appear if you produced another statement for a different month.

This may have occurred because you Bookout-Charged the job after the end of the month but  forgot  to
alter the Tax Date in the Bookout confirmation window.

If  the  job/document  has  been  Posted  then  you  won't  be  able  to  change  it,  so  either  explain  to  the
Surgeon  that  it  will  appear  on  a  future  statement,  or  issue  a  Credit  Note  and  create  and  Bookout-
Charge a new Job/Document using the correct Tax Date.

To change the Tax Date, bring the job onto the screen, choose Action... Modify, then Action...  Bookout
& set the Tax Date.

2. The Job/Document is not  yet  Bookout-Charged.  If it  was simply  Booked-Out  (Action...  Book  Out  F8)
then Transactor thinks it is an ongoing job pending return from the Surgeon. If you intended to book this
job out and charge (raise an invoice),  retrieve the job onto the Main Form, choose Action..  Modify,  then
change the On Book Out  box to Charge.  Finally  choose Action..  Modify.  You may want  to set  the Tax
Date as appropriate in the confirm dialog.

16.8 Computer Crashes

If your computer restarts  normally  your data  should  be  intact,  otherwise  please  Contact  Us  before
doing anything.

If you were editing a job when the computer crashed, you should be notified of any data errors  when you
restart  Transactor.  There is  a utility  which will  usually  repair your data if damaged,  although  you  may
lose the job document you were editing at  the time.  This  utility  is  available from the Maintenance Menu

.

16.9 Walk thru Payment allocation and Credit Note

In this section we'll use the Example Transactor to enter some sales receipts, look at how they are
allocated to invoices and how to create and allocate Credit Notes.

Start the Example Transactor Dental Lab (See the Coffee Break Tour installed with Transactor)
Select the Surgeon  Adams B onto the Main Form
Press F11 to View the Account History
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All the transactions in the list are blue indicating we haven't done any Locking and Posting of Jobs
yet. 

The dates of the sample Transactions may be different on your system but it doesn't matter, just accept
your dates will be different to our examples here.

Notice the Paid column is clear, none of the Invoices have been 'paid' yet.

Close the Account History window
From the Surgeon menu, choose Payment..
Enter the amount of £ 2119 and choose Ok

In the Allocate Credit form, Choose Auto-Apply (This is the default button you can just press Enter)

104
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Looking down the list, you can see that Job document 1359 has a balance of 30.50. This is because the
surgeon has decided not to pay for Job document 1344 and the auto-apply facility uses a oldest-first
method to allocate credits.

This Surgeon will need a Credit Note unless it is to remain in dispute. We'll do that later, for the moment
we'll just apply the Cheque amount and carry on.

We can deal with the part-allocated credit in two ways. We'll be using Method one in this walk thru.

Method One
We could leave the Auto-Applied allocations as they are. Once we have made a Credit Note for the
30.50 we will Auto-Allocate that credit and that will pay off the part balance showing.

Method Two
We could choose Un-Apply, then highlight all the Invoices up to DocNo 1344, choose Apply and then
highlight and Apply the remaining Credit to to the other valid three invoices in turn. 
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When we have created a Credit Note we'll be able to use that to allocate to the £30.50 balance on
document 1344.

Close the Allocations window

Notice the Cheque Payment is now in the Account History window and that the Cheque didn't quite
payoff the months invoices. Remember that Job Docno 1344 is really the one which should be showing
as Part paid.  We'll resolve that now.

Issue a Credit Note  for the disputed Job (Docno 1344)69
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TIP
When you do credit notes, keep an eye on the Tax Date if you want your Statements to show it in then
correct month.

Ah ha, the Credit Note is now in the surgeon's Account History!

In the surgeon's Account History window, right click the Credit Note and choose Allocate Credit..
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Choose Auto-Apply

The allocation is now done. Choose Close.
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We are now ready for the Walk thru of an end-of-month statement and posting .

 

16.10 Do the end of month Statement and Locking

In this section we'll use the Example Transactor to produce a Statement. 

We'll also run the Locking and Posting Jobs  tool to protect finalised jobs dated upto the previous
month from being modified accidentally.

If you haven't done the preceding topic Walk thru Payment allocation and Credit Note  then bear in
mind the transactions in our example will be different, the Cheque Sales Receipt will not be there. 

Start the Example Transactor Dental Lab (See the Coffee Break Tour installed with Transactor)
Select the Surgeon  Adams B onto the Main Form
Choose Reports / Surgeon Statement (Monthly) for Mr Adams..

On the statement you can see any transactions, payments or credit notes that have a tax date in that
month.
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In this example there are no unpaid invoices or unallocated credits  and so as at the end of this
Statement month, the surgeon's account balance is zero.

What sort of things could throw you off here?  Well you may print a statement and find the Surgeon's
sales payment or invoice that should be on a statement but isn't. This is more than likely because the
Invoice or Payment's Tax Date needs changing. See Invoices Not Showing
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Once you are happy with your Statements you should 'close' down that month's transactions by running
the Locking and Posting Jobs  tool to protect finalised jobs from being modified accidentally.

17 Did You Know.. ?

Did you know you can work with two Main Forms at the same time?
Use the FormA and FormB button at the top left of Transactor's main window. More..

Did you know you can find a Job even if you don't have the Doc/Job No or Surgeon Account?
You can either search for the job by Patient Name  or look through the list of Jobs by Date and Job
Status. More. .

You can add or remove automatic lineitems from the Job Template area that show on new jobs?
You can configure Transactor to automatically have a certain layout on the screen when a new job is
started. Any of your existing defined Line Notes can be made to appear in the new job. More..

Did you know that you can buy a Battery Backup unit that will protect your computer from power
interruptions.

See Protect your PC from power failures

Did you know Transactor can be configured so you don't have to log in?
See Enable username and password log in

Did you know you can use Transactor to implement a Quality Control System on your Customer
Services? 

You can record and monitor customer enquiries and complaints using Query Documents  

Did you know you can Email Invoices and Reports? 
See the FAQ How to Email Documents, Invoices or Reports

Did you know you can see what's been going on in order of when it happened
In Main Form, from the View Menu, choose Recent History (CTRL-R)

Did you know you can produce your own reports, labels and lists via the Export tool
In Main Form, from the View Menu, choose Tools - Export Data . Use this tool for exporting data to
your Spreadsheet tool for printing custom reports, address Labels, mail-merge letters, or product lists
etc

17.1 You can work with two Main Forms

Two Main Forms can be open at the same time, this could be helpful for cases such as when you are
half way thru working on a Job when the you need to quickly respond to an enquiry about another job.

While you are have the job details of one job on the Main Form, choose the other Form Button on the
main tool bar.
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The second form may be blank or may contain another job's details.

You can use the Form Buttons to switch between the two Forms or use the Window menu.
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18 Contact Us

Website Contact Us 

www.transactor.co.uk 

Telephone sales & technical support 

Telephone technical support is available only to new customers in the trial period, and Premium
Support customers. 

01424 777877 

Write or visit 

Pearce & Robinson LTD
17 High Street, Battle, Sussex TN33 0AE
Tel: 01424 777877

NOTES
Sales & Support Telephone Mon-Fri 0900-1700hrs excl. Bank Holidays. 
After your free Premium Support period is up you can purchase 12 months renewal from www.
transactor.co.uk

19 Endnote

We hope you enjoy using Transactor and that you are very satisfied with the product and our support
services. 
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While you are trying Transactor you are entitled to free Technical Support .

We welcome feedback of all types so we look forward to hearing from you. Our preferred method of
feedback is via the website.

Thank you for using Transactor

The Transactor Team
Battle, UK

See Also
Contact Us
Getting help
How to buy Transactor
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